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Micro Focus Enterprise Developer 6.0 for
Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Documentation Web
site for any updates to the documentation which might have been uploaded.

Product Overview

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Enterprise Developer can automatically relink the existing executable or .dll to the new version of
the C run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.
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What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 6.0 release.

Enhancements are available in the following areas:

• .NET Core
• Building Applications
• CICS Support
• COBOL Application Console Size
• COBOL Language Enhancements
• Code Analysis
• Code Analyzer Refactoring
• Compiler Directives
• Containers
• Database Access - HCO for DB2 LUW
• Database Access - OpenESQL
• Database Access - XA Switch Modules
• Data File Tools
• Debugging
• Enterprise Server
• Enterprise Server for .NET
• Enterprise Server Security
• Enterprise Server Common Web Administration
• File Handling
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Library Routines
• Micro Focus Database File Handler
• Micro Focus Unit Testing Framework
• Microsoft Build Tools and Windows SDK Configuration Utility
• Multi-Threaded Applications
• PL/I Support
• Visual Studio Integration
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.NET Core
Back to Top

Support has been added for .NET Core 3.1, and a number of new .NET Core project templates have been
added.

Note: Because Enterprise Developer requires .NET Core version 3.1 and .NET Core version 3.1 is
not supported by Visual Studio 2017, you must be using Visual Studio 2019 to be able to use
Enterprise Developer to create COBOL applications to be deployed for use with .NET Core.

Building Applications
Back to Top

This release includes the following new functionality:

• Compiling Mainframe Subsystem Application projects now continues on error - all compiler tasks for the
different file types will now continue to run, if one of the tasks reports an error.

CICS Support
Back to Top

This release provides the following enhancement:

• Viewing CICS PCT Resources inside Visual Studio (Technical Preview)

You can now view CICS PCT resources from within Visual Studio. You can do this with the help of a
context menu command, Show CICS Resources, for an enterprise server in Server Explorer.

A context-menu command, Create PCT, is available in Solution Explorer for COBOL programs which
are part of a Mainframe Subsystem Application project associated with an enterprise server instance.

COBOL Application Console Size
Back to Top

The maximum console size of a COBOL application has increased. It can now be 255 lines by 255
columns, configurable using the screen_lines and screen_cols run-time tunables.

COBOL Language Enhancements
Back to Top

The following enhancements are available:

• Enterprise COBOL 6.2 Update - new syntax, library routines, and the respective analysis tooling are
available for compatibility with IBM's Enterprise COBOL 6.2 Update:

• New intrinsic functions are supported: BIT-OF, BIT-TO-CHAR, BYTE-LENGTH, HEX-OF, HEX-TO-
CHAR, NUMVAL-F, TEST-NUMVAL, TEST-NUMVAL-C, TEST-NUMVAL-F, and TRIM

• A number of intrinsic functions now support national data (especially surrogate pairs): REVERSE,
ULENGTH, UPOS, USUBSTR, USUPPLEMENTARY, UVALID, and UWIDTH.
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• A LOC phrase has been added to the ALLOCATE statement to define whether memory is allocated
above or below the 16MB line.

• CONSTANT qualifier - it is now possible to define data items as constants. This improves the code
readability and usability, and helps detect programming errors. The ability to create constant items is
already in .NET COBOL and JVM COBOL, and many other languages.

• Local variable declarations in native COBOL - it is now possible to declare data items inline in the
code and not only in a separate DATA DIVISION. This provides better locality of data, making the
source code easier to reason about.

• Native data type to hold strings of utf-8 characters - in native COBOL, support is now available for
the PIC U data type as introduced by IBM in Enterprise COBOL version 6.3. Direct support is available
for utf-8 data.

• Performance improvements - this release provides various performance improvements, most
significantly on 32-bit Intel x86 platforms. When using the highest optimization level, opt(4), the
performance of native code generated by the COBOL Compiler has improved. A number of cases are
affected, most particularly those where it is beneficial to locate PERFORM ranges inline.

Code Analysis
Back to Top

Support is provided in Enterprise Developer for accessing the Application Analysis Server which is part of
the Micro Focus Enterprise Analyzer and Micro Focus COBOL Analyzer products.

If you have one of these products installed, you can connect to the Application Analysis Server from Server
Explorer and access the Enterprise Analyzer web client. Enterprise Analyzer web client provides quick
searches for repository objects, detailed code searches, diagrams, reports, and data item impact analysis
and other features such as viewing and editing of business rules (separate license required).

Code Analyzer Refactoring
Back to Top

Support is now available for extracting program logic from COBOL code and moving it to a new program.
The following commands are available from the editor context menu:

• Create program from Section
• Create program from Computation
• Create program from Condition

Compiler Directives
Back to Top

The following Compiler directives are new in this release:

• DISPLAY-AT - specifies a default foreground and background color for DISPLAY AT and ACCEPT AT
statements that do not specify any color attributes.

• DPC-IN-DATA - controls whether the DECIMAL-POINT IS COMMA clause (if specified) is applied to the
output from the XML GENERATE and JSON GENERATE statements.

• ILCONDITIONPARAM - switched on by default. Enables the support for conditional expressions as
method parameters.

Important: Applications that use the old COBOL syntax for specifying named parameters as
custom-attributes will not compile with the ILCONDITIONPARAM specified. This can result in any
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older applications failing to compile in the current version of the product. See
ILCONDITIONPARAM for details about how to work around this issue.

The following Compiler directives have new options:

• CHECKREFMOD - now takes an additional parameter (NOZEROLENGTH), which acts as
CHECKREFMOD, but does not permit reference modifier lengths of zero.

• PROTOTYPE - now supports options that specify whether prototypes are required, and the severity of
error messages issued for prototype mismatches.

Containers
Back to Top

Support has been added to enable you to work with containers from the IDE. In particular you can now
create a Dockerfile for a COBOL project, and build, debug and run a COBOL project in a container, all from
the IDE.

Database Access - HCO for DB2 LUW
Back to Top

Support for the following has been added to this release:

• Multi-row fetch (MRF) and insert (MRI) statements with or without the FOR ROWS clause
• Array update and delete statements

Notes:

• These new features are supported for DB2 LUW version 11.1 Mod 4 Fix Pack or newer. Currently,
IBM does not support either of these features with DB2 LUW 11.5.

• For coding examples, see the IBM DB2 LUW documentation: Embedded SQL/COBOL Support for
MRI and MRF.

Database Access - OpenESQL
Back to Top

Support for the following has been added to this release:

• .NET Core 3.1 with the COBOL .NET Core project templates "Console Application" and "Class Library"
using OpenESQL directive DBMAN=ADO.

Database Access - XA Switch Modules
Back to Top

Support for the following has been added to this release:

• XA switch modules have been enhanced to enable storage of sensitive information in the Micro Focus
Vault Facility. This new functionality includes a customizable program, ESXAEXTCFG.CBL, you can use
to obfuscate xa-open strings by storing them as secrets.
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Data File Tools
Back to Top

The following enhancements have been made to the Data File Editor:

• Double-byte character sets are now supported within the editor.
• Insert mode is now available when editing a formatted record, except for numeric fields.
• When editing DBCS data in EBCDIC files, the required Shift-out and Shift-in characters are

automatically added when editing a formatted record and you are editing in Insert mode.
• You can now load and unload structure files for an open data file.
• A ruler at the top of the editing pane can be toggled on/off.

Debugging
Back to Top

The following enhancements are available:

• Debug profiles - COBOL projects now support debug profiles, a feature of Visual Studio, where a debug
profile stores a set of properties which specify how to start debugging the application. You can create
and manage multiple debug profiles available on the Debug tab in the project's properties.

• Expressions - you can now specify complex expressions in the Watch window. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Watch Window for details.

• Debugging MSS applications - a new Visual Studio configuration option, Do not stop on program
entry, is available. With this option enabled, the debugger does not stop execution on any entry to a
program in a native Mainframe Subsystem Application and continues to run until it detects a breakpoint.

Enterprise Server
Back to Top

The following enhancements are available:

• Definition Import/Export Tool - a new utility, casesxml, has been added to enable you to import and
export enterprise server definitions. Using casesxml you can do the following:

• generate .xml files, in casesxml export format, that contain structured definitions of a region, a
CICS resource definition file, and the catalog

• import a casesxml export format .xml file to update the definitions of a region, a CICS resource
definition file, and the catalog

• IPv6 support (EAP) - This feature is in Early Adopter Program (EAP) release status. Some Enterprise
Server components and features now support Internet Protocol version 6 (IPv6) network addressing
and connectivity. Due to limitations with IPv4, IPv6 is becoming more common within corporate
networks and on the public Internet. In some cases, the use of IPv6 can improve interoperability and
simplify network configuration.

• Administrative Commands - the add command in cascertreg now contains new options (-cwi
setting, -dcas setting, -issuer, and -subject).
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Enterprise Server for .NET
Back to Top

This release includes the following improvements:

• SOAP web services for CICS (EAP) - an Early Adopter Program (EAP) feature. Enables you to create
SOAP web services for CICS transactions. This enables you to expose CICS transactions as SOAP
web services using IIS, including translating data between SOAP and COBOL formats, and applying
security rules.

• ELF and DCAS - Enterprise Server for .NET now provides the Digital Certificate Authentication Service
(DCAS) and supports the TN3270 Express Login Facility (ELF), also known as Certificate Express
Login (CEL).

CICS users can be signed on to the region using TN3270-over-SSL and a client certificate. Enterprise
Server for .NET can also be integrated with DCAS-based mainframe SSO technologies such as Micro
Focus Host Access for Cloud (formerly Host Access Management and Security Service).

• EXCI enhancements - the External CICS Interface (EXCI) feature now supports channels and
containers, which allows larger requests and responses. It also includes some additional security
features. This provides an improved integration between Enterprise Server for .NET CICS and external
applications, whether standalone programs or application code running under other servers such as IIS.

• Administration ESF and LDAP-based security - the MMC Administration console now uses the
External Security Facility to control access to administration functions. The role-based security provided
with earlier versions of the MMC UI has been integrated into ESF as the default security option for the
MMC UI, but it is now also possible to use LDAP-based security and/or Windows authentication. This
provides you with more administration security options, including using the same security manager and
schema for region and administration security.

• LDAP-based security enhancements - the LDAP ESM Module for Enterprise Server for .NET offers a
number of enhancements, including fixes for bind-mode user authentication, support for the "user ID
attribute" configuration setting, support for long passwords, and the passtoken/passticket feature. This
provides a greater flexibility for organizations using LDAP-based security with Enterprise Server
for .NET. Passtoken and passticket support was also used to enable the DCAS feature.

Enterprise Server Security
Back to Top

This release provides the following enhancements:

• Micro Focus Secrets file storage permissions

The Micro Focus Secrets feature (also known as the Vault feature) provides centralized storage for
sensitive information such as passwords, with some protection against accidental disclosure or
discovery by unauthorized users. Prior to this release, the only supported storage mechanism was a
conventional file containing encrypted data. In this release, the permissions on the storage file and on
the Secrets configuration file are set more restrictively to help protect the secrets.

• Certificate wildcard support

The X.509 digital certificates used to identify servers when making TLS (SSL) connections permit the
use of fully-qualified domain names with wildcards for some parts of the name. This enables
administrators to use a single certificate issued to, for example, *.mycorp.com for any number of servers
with fully-qualified names like www.mycorp.com, server1.mycorp.com, and so on. These wildcard-
bearing certificates are now supported by client programs using Micro Focus communication technology
when validating a server's certificate.

• Improved ACL wildcard support
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In the Access Control Lists used for resource access control with LDAP-based security in Enterprise
Server, the ".**" wildcard sequence now behaves more similarly to mainframe RACF. A number of
additional options for wildcard processing are also available.

• PKIX compliance for TLS certificate validation

The standard for using X.509 digital certificates to authenticate servers when making TLS (SSL)
connections is known as PKIX, for Public Key Infrastructure (X.509). It is defined by a series of IETF
RFC documents, currently RFC 5280 and others. In previous releases, the certificate validation
performed by this product did not conform to PKIX in a number of ways, most notably in using DNS
address-to-name resolution in an attempt to match a certificate to a host. With this release, clients using
Micro Focus Common Client technology, such as COBOL web service proxy programs, CAS utility
programs, and customer applications that use the CICS Web Services Interface feature, will by default,
use stricter procedures for validating certificates which more closely conform to PKIX. This improves
TLS security and interoperability.

• Security improvements for XML parsing

In this release the third-party components used for parsing XML data have been updated, or have had
bug fixes integrated into the version used by Micro Focus, to address published security vulnerabilities.
Also, XML external-entity support has been disabled except where it is required by a particular product
feature; this prevents XML External Entity (XXE) attacks on customer systems by attackers who can
trick a customer application into parsing a malicious XML document.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

This release offers the following new features and improvements:

• MFDS User Interface functionality replacement - ESCWA can now communicate with remote MFDS
instances, and displays the equivalent pages of MFDS. Configuring regions, and their IMS, PL/I, MQ,
and XA options, and security, is now available.

• ESMAC User Interface functionality replacement - ESCWA can communicate with remote ESMAC
instances, and can replicate functionality and display all the information provided by ESMAC.

• Configurable User Interface access - you can now configure the ESCWA security manager to control
user and group access to certain aspects of the user interface, such as, native, Enterprise Server
for .NET, and security menu items.

• Usability improvements

• Starting and stopping regions from the navigation tree.
• The native menu items are not displayed if the region features are not configured correctly.
• Configuration of the display colors for MFDS hosts and regions to distinguish them with ease.

• CICS resource support - the following resources are supported: ICEs, DocTemp, TCPIPService,
URIMap, Bundle, Pipeline, and WebServices.

• Scale-Out support - ESCWA has improved the way it displays a Scale-Out Repositories (SORs)
association with its PAC and member regions.

• Redis support - Redis is supported as a SOR when running this product in a PAC. Features include:

• Redis cluster support
• A Mfredis configuration file - enables you to configure reconnection when any network errors occurs.

You can also use the file to configure Lua scripts tracing on servers.
• Authentication support for the standalone Redis server.

File Handling
Back to Top
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Fileshare password files can now be stored in the Vault Facility, ensuring that sensitive user credentials are
encrypted. Firstly, create the password file in the usual way, and then upload it, with a path of
microfocus/fh, using the mfsecretsadmin utility.

To ensure the Fileshare server uses the file stored in the vault, start the server with the /uv option.

IMS Support
Back to Top

Improvements are available in the following areas:

• BMP inbound and outbound message processing - full support is available for BMP inbound and
outbound message processing. Batch message processing programs (BMPs) can now access the IMS
message queue for input and output, in addition to their batch-type processing and data-access
capabilities.

• Commands - the following commands are now supported: - /START TRAN ALL, /DISPLAY Q TRAN,
and /DISPLAY STATUS TRAN.

• DB Control SUSPEND / RESUME commands in an active system - IMS DB Control supports the
SUSPEND command while transactions are active. DB Control will block any new units of work and
allow active UOWs to complete during a quiesce. Once DB Control reaches a state with no outstanding
UOWs it suspends. Note a long running BMP may prevent a system from suspending.

This enables support for administrative tasks such as database and transaction log archiving. It also
enables the creation of new transaction logs when roll forward recovery is enabled.

• IMS BTS trace - IMS BTS trace is now visible from active SSTM and batch jobs. WIDTH and NOHEX
options have been added for additional control of trace output format.

This enables BTS output to be viewed when debugging a batch IMS application. Previously the job step
had to complete before the trace was visible. This also enables you to view the trace output in an active
SSTM job. Previously the MPR had to be stopped to make trace output visible.

• User DB handler exit - database exit support has been added for GSAM databases. This provides
programmatic control of the DB Catalog setting for a database instead of using the defined DB Catalog.
Also, this exit can process DL/I calls completely, for example, to map DL/I calls into VSAM I/O requests.
Previously, this exit was available only for full function databases.

To assist you with writing an exit, a template file, USERDB.CBL, and an explanatory text file,
USERDB.TXT, are available with your IMS classic samples.

• Visual Studio IDE support - a new context menu command, Show DBD List, for Visual Studio
projects enables you to view a list of all generated databases used by the project.

Interface Mapping Toolkit
Back to Top

Improvements are available in the following areas:

• Resource-based REST APIs - the following enhancements enable the creation of resource-based
REST APIs:

• Operations in JSON RESTful Web services can now have a customizable URI path that identifies a
resource. Operation paths have support for dynamic templating.

• API resources can now be automatically identified from COBOL groups in a COBOL program, and a
set of operations can be generated for each API resource.

• It is now possible to specify the location of interface fields in the service request or response. An
interface field can either be a parameter in the URI path, a query parameter, or be in the JSON
message body.
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• Summary support for OpenAPI - the IMTK now supports the OpenAPI Specification (originally called
Swagger) which is the most widely-accepted format for REST API specifications. Features include:

• Consumption of OpenAPI 3.0 and Swagger 2.0 files for purposes of client and service generation.
• Generation of OpenAPI 3.0 files to describe the APIs of a JSON RESTful Web service.

• REST service output filtering and field selection - Enterprise Server JSON RESTful Web services
now include the following features:

• Automatic filtering of the JSON response body of a Web service by path and query parameters
received in the request URI.

• A special query parameter "$fields" that can be used to indicate that the JSON response body is to
contain only certain specified fields, and to exclude all other fields.

• REST API discovery - Enterprise Server API discovery is now supported. For a JSON RESTful Web
service, a list of all its available operations, and their URI paths, can be retrieved. This enables a client
to efficiently navigate an Enterprise Server REST Web service without having information about the
service’s operations ahead of time.

JCL Support
Back to Top

The following features have been added to the JCL support:

• The sample printer exit in the product has been enhanced to retrieve extended information. The
structure defined by idadoutp.cpy now contains two new entries (ws)-extended-output and
(ws)-extended-data. The item (ws)-extended-output contains the version of the extended
output data; currently, this should be set to 1. The item (ws)-extended-data is a pointer, that if null
means there is no extended data; otherwise, it points to a new structure defined in outpext.cpy. That
structure contains the extended output information for a given job. This is demonstrated in the provided
sample - sampprnx.

Library Routines
Back to Top

The following library routines are new:

• MFU_GET_FILE and MFUGETF - both these routines are used with data-driven tests in the Micro
Focus Unit Testing Framework. If the .csv file under test references external data in one of its cells
(using the @file-name notation), use either of these routines to load that external file into memory
before such tests are run.

The following library routine contains new functionality:

• CBL_GET_EXIT_INFO - this library routine has been enhanced to better detect the circumstances in
which an exit procedure has been invoked.

The Micro Focus Database File Handler
Back to Top

Support for Db2 and Microsoft Azure databases has been added to the Micro Focus Database File Handler
(MFDBFH). This support is equivalent to that of the existing databases.

The following features have been added for all databases:
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• I-O optimizations for sequential, line sequential, and ESDS/KSDS/RRDS files opened for output.
• Using direct connection strings to make a database connection (as an alternative to using ODBC

DSNs).
• Creation of databases using script files.
• Maintaining database configuration files with a command line utility, dbfhconfig.
• Using the dbfhdeploy utility to delete data files from a datastore.
• Database configuration files can now store confidential information in the Vault Facility.
• CTF tracing of ODBC and Vault operations.
• Recovering of locked processes or files can with the dbfhadmin utility.
• The dbfhconfig and dbfhdeploy utilities are now capable of executing commands batched up in a

response file.

The Micro Focus Unit Testing Framework
Back to Top

The following enhancements have been made to the Micro Focus Unit Testing Framework:

• You can now run unit tests against an executable file from the command line. Before you run such tests
from the command line, you must initially rebuild the executable in order to link it into the testing
framework.

• You can now produce a report file that can be opened and viewed in Microsoft Visual Studio. Use the -
report:trx command line option to generate a .trx file.

• The .csv source files used in data-driven tests can now reference external data: use the @file-name
notation in a cell to use the contents of file-name in the tests. The external source files must be
loaded into memory, using the MFU_GET_FILE or MFUGETF library routines, before the tests are run.

• Two new elements are available for data-driven tests: a data-driven setup and a data-driven teardown.
Conventional setup and teardown entry points would run multiple times during a data-driven test; these
two entry points run only once per test run.

The Microsoft Build Tools and Windows SDK
Configuration Utility

Back to Top

On Windows, the Enterprise Developer setup file now installs the Microsoft Build Tools and the Windows
SDK packages, as these are dependencies for a number of features and operations of the product.

You can use the Microsoft Build Tools and Windows SDK configuration utility to view the package versions
in use in your COBOL environment. You can also use this utility to set the environment to use other
versions of these packages that you have installed.

Multi-Threaded Applications
Back to Top

This release includes the following improvements:

• Thread local storage optimizations - the thread termination in applications with many threads has been
optimized.
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PL/I Support
Back to Top

Enhancements are available in the following areas:

PL/I compiler

Improvements in the compiler make it easier to migrate existing applications to new platforms. Support is
available for:

• The GENERIC attribute on an ENTRY declaration.
• The COPY option of the GET statement.
• Assignment of an ENTRY to an ENTRY LIMITED variable.
• The INONLY attribute.
• Support for a SELECT with no WHEN or OTHERWISE modified to match IBM’s behavior.
• Support for new compile option which allows specification of the FIXED DECIMAL precision for

intermediate operations.
• The ability to use LIKE on a structure that contains * for element names.
• Built-in functions:

• New functions - FIXEDDEC and FIXEDBIN
• The TRIM built-in function to support its usage with structures.
• The VALID function - improved support when used with FIXED DEC arguments.
• Function precision of 15 or 31 (see the –bifprec compiler option)

• PL/I bytestream IO via FILEREAD, FILEWRITE, FILETELL and FILESEEK statements.
• Improved compatibility - when using DEFAULT RANGE with patterns; for use of the STRING

pseudovariable.
• Improved support for - structures declared with the LIKE attribute where the referenced structure

members contained NOINIT attribute(s).

Improved functionality for customers using Open PL/I to develop z/OS applications is available:

• Improved compiler listing to show attributes of parameters to an ENTRY declaration.
• Improved expanded listing showing line numbers for code generated by preprocessors.
• Improved compiler diagnostics when trying to use BIT operators on non-BIT operands.
• Improved compiler diagnostics when an unqualified name is resolved to a structure member rather than

a matching non-member declaration of the same name in a parent block - Informational (I-level)
diagnostic (MFPLI01305I).

• A string indicating which compiler was used to generate the object code is now embedded in every
compiled routine to facilitate ease of upgrading and troubleshooting by customers.

• *PROCESS statements are now mapped to the equivalent Open PL/I compiler options where
appropriate.

PL/I EXEC preprocessor

• Information about host variable references and modifications is now available for the background
parsing.

• %SDEBUG and %RDEBUG statements now indicate the line and column where the macro invocation
starts or ends.

Macro preprocessor

• Supports the new SOURCEFILE() built-in function
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• Improved compatibility for %DO statements
• %SDEBUG and %RDEBUG statements now indicate the line and column where the macro invocation

starts or ends

Run-Time System

• Support is available for bytestream IO via FILETELL, FILESEEK, FILEREAD and FILEWRITE for
RECFM(U) files.

• Support for the COPY option of the GET statement.
• It is now possible to use a STATIC FIXED BIN(31) variable to control the RECSIZE of a file at OPEN

time.
• The JCL utility IKJEFT01 can now be driven from PL/I as a callable interface.

Visual Studio Integration
Back to Top

The following enhancements are available:

• Support for the Visual Studio CodeLens feature (Visual Studio 2019 and later only) - CodeLens is a
clickable visual adornment ( , ) above entry points or number of references above class, section, or
paragraph names.

In Run Units, CodeLens provides the number of entry points, and also enables you to run and debug
directly from the editor.

• New formatting options - you can now specify different indents for the parent and child items in group
item data in Tools > Options > Text Editor > Micro Focus COBOL > Formatting > Data Division.

• Tooltips for END delimiters - tooltips are available for END delimiters such as end-if, end-perform, or
end-of-statement period. The tooltips show the opening statements.

• Code style preferences - a new category of preferences, Tools> Options > Text editor > Micro Focus
COBOL > Code Style, combines all Visual Studio preferences for the format and style of your COBOL
code.

• Lightbulbs - quick actions are available for inserting an end-of-scope terminator (such as END-IF), and
for extracting sections to new programs.

• Snippets - a new snippet for indexers is available.
• Uppercase mode - to toggle uppercase mode, click  (Force upper case in the editor) in the COBOL

toolbar, or enable it from Tools > Options > Text Editor > Micro Focus COBOL > Text Casing). With
this option enabled, code you insert or paste in the editor, including snippets, is forced to upper case.
This functionality must not be used with .NET COBOL.

• QuickInfo - information in the QuickInfo details is now colorized.
• Copybook properties - the Properties window now displays the full path for copybooks that are stored

outside of the project.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• Call prototyping in library routines
• Common Communications Interface
• Communications Server
• Compiler
• Database Access - OpenESQL
• Data Tools
• Documentation
• Early warning of compatibility issues with current operating systems
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server for .NET
• Enterprise Server Security
• File Handling
• Handling of Anonymous Root Field in JSON
• HCO for DB2 LUW
• IDE
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• National data items in .NET COBOL code
• PL/I Support
• Run-Time System
• SQL Option for DB2
• VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when

ODOSLIDE in effect

Adis

Back to the list

• In RM/COBOL, the ACCEPT of a screen with an input field beyond the end of the screen would operate
as if the field was at the last character of the screen. Previously, ADIS would ignore any fields past the
end of the screen. Now, with Dialect"RM" set and the appropriate ADISCTRL settings, behavior will now
match RM/COBOL in this case.

3138718 (1112690)

Assembler Support

Back to the list
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• A problem with the MFASM command-line processor program caused RC=4 warnings that prevented
the linker from being invoked. To correct this, the MFASM.EXE and MF370CHK.DLL modules have
been updated to produce .390 executable modules even when warnings occur during assembly.

3224507 (1119933)
• A problem that caused the &SYSNEST macro processor to be incompatible with mainframe assembler

has been fixed by reducing the system value by 1.
• A problem that caused National Language Characters in assembler listings to be echoed to the console

during assembly and appear as box drawing characters has been fixed.
• MNOTE errors are no longer treated as fatal errors. If only MNOTE errors are reported at assembly

time, the Assembler .obj file will be produced and the linker will be invoked.

3204758 (1118136)
• Invalid parameters specified in the Additional Directives text box are no longer treated as fatal errors by

the Assembler command-line processor. Previously, invalid parameters would prevent the Assembler
linker from being invoked even if the assembly was successful.

3204319 (1118090)

Call prototyping in library routines

Back to the list

The copybooks cbltypes.cpy and cblproto.cpy, provided by this system for call prototyping in library
routines, include features of the latest syntax, specifically the CONSTANT keyword. If these files are used
in conjunction with the MF directive, it should be set to the current level, 21; otherwise, you should remove
the directive, or do not use these copybooks.

Common Communications Interface

Back to the list

• The default TLS Security Level has been increased from 0 to 1. This change will not affect any user that
has specified their own security options. Users relying upon the default TLS security options might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See "Security Levels" and "Specifying a Server Protocol and Cipher Suite Preference" in your product
Help for more information on the change to Security Level 1.

Communications Server

Back to the list

• The optional Digital Certificate Authentication Service (DCAS) feature of Enterprise Server, most
commonly used to provide single-sign-on for TN3270 clients, has been updated to address a severe
security issue. Customers using DCAS should refer to the topic "DCAS security" in the product
documentation. To determine whether your enterprise server regions use DCAS, look for listeners with
the "dcas" conversation type. DCAS listeners now require client certificate authentication by default. If
you are using DCAS with an external DCAS client such as Host Access for Cloud (formerly Host Access
MSS), and that client does not supply a certificate, you need to add the following setting to your DCAS
listener configuration: [Operation] allow unauthenticated clients=yes

Compiler

Back to the list

• "file not found" error messages now provide more information about the key the user needs to press.
The new format of the messages is as follows: "File name.cpy not found - Press [S]top/[R]etry/
[C]ontinue/[A]lter-path".
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• External data and files declared in an instance context (such that is not within STATIC/END STATIC and
without the STATIC qualifier) can no longer be accessed from a static method. The STATIC qualifier is
now allowed in combination with EXTERNAL.

3216822 (1119228)

Data Tools

Back to the list

• You are no longer able to modify data in a structured record that is identified as comp-2 floating point -
an alert is displayed if attempted. This is in order to prevent the data becoming corrupted.

3213037 (1118867)
• Data File Tools now utilizes the configurable codesets facility to use a variety of character sets - see

'Working with Different Character Sets' in the documentation for more information.

3161243 (1114482)

Database Access - OpenESQL

Back to the list

Just like other DBMS SQL COBOL precompilers, OpenESQL now follows embedded SQL standards and
disallows the use of group host variables in WHERE <column> = :hostvar clauses. In the past, this was not
flagged at compile-time, and would lead to unpredictable results when executed.

Documentation

Back to the list

• The information about the -flag and warn compiler options has been updated.

3190928 (1120000)

Early warning of compatibility issues with current operating systems

Back to the list

In order to better support modern operating systems, we are aligning closely with their operability
guidelines. We now detect previously-undefined behavior when interacting with OS level functions.

Error RTS096 alerts you to any calls to the operating system's fork() API, in a process that has directly or
indirectly called COBOL functionality, in your code.

The error gives you an early diagnosis of a situation which, if left unchecked on modern operating systems,
could lead to deadlocks, crashes or other failures at run time. These problems would often occur
intermittently and be very challenging to track down.

See the KB article https://community.microfocus.com/t5/Visual-COBOL-Knowledge-Base/fork-rts64-
Error-96-encountered-in-child-process/ta-p/1771191 for more details.

Enterprise Server

Back to the list

• IF an XA open string uses the BATCHONLY option, CRCN will not monitor the XA connection to the
resource manager. If the BATCH SEP encounters a severe XA error, the batch SEP will be recycled
until the connection is recovered. This emulates the previous version of the XA reconnect feature when
ES_XA_????_NB_RETRIES=-1 was set. Consequently, if an open string contains BATCHONLY, only a
batch SEP will be able to access the resource manager and, as CRCN is a CICS transaction, it will not
monitor this entry.

3213379 (1118913)
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• The initPac option for the caspac command line utility has a change in behavior. Prior to PU5, if the
command detected that there were active regions in the PAC, the command would return an error and
not initialize the PAC. This only occurred when: 1. There are active regions in the PAC. 2. There are no
active regions in the PAC, but a region has shutdown without notifying the PAC SOR (PSOR), for
example, if the region was killed. In this case, it was not possible to cold start a PAC without manually
correcting the appropriate value in the PSOR. The initPac option will now prompt for confirmation on
whether you really wants to initialize the PAC, giving you the option to cancel. CAUTION: Only use this
option for scenario 2, ensuring that no cas* or mfcs processes remain for regions within the PAC. If it is
used when there are active regions in the PAC, the regions will no longer function correctly.

(642125)
• Enterprise Server now supports Redis Cluster as a SOR. See "Prerequisites" in the "Scale-Out

Performance and Availability Clusters" chapter in your product Help for more information.

• When compiled with the XAID Compiler directive, JCL batch SQL applications now work correctly when
MFDBFH is enabled.

3223257 (1119804)

• Deferred work elements for cancel will not be processed until the End of Task. This means that the
cancel will not be processed during a user syncpoint.

3193871 (1117144)
• A problem where a failed syncpoint did not result in a failed transaction, leading to incorrect commit

states, has been fixed by changes in syncpoint processing. A syncpoint involving XA resource
managers can fail in one of three ways: 1 - During phase 1 - xa-prepare. When one of the RMs enrolled
in a LUW returns an error on the prepare, the LUW is rolled back. An application can now intercept the
EIBRESP and EIBRESP2 using the NOHANDLE option: EIBRESP = 78-EIBRESP-is-ROLLEDBACK -
82 EIBRESP2 = 78-EIBRESP2-sync-prepare - value 124 Otherwise the transaction abends with abend
code AEXJ - ROLLEDBACK. 2 - During phase 2 - xa-commit or xa-rollback. When one of the RMs
enrolled in a LUW returns an error on the commit, the LUW is left as is, and a severe error is sent to the
console. The application cannot handle this failure. (This is mainframe-compatible behavior.) 3 – A
syncpoint can also fail during the systematic xa-start called after the completion of the syncpoint commit
phase 2. Behavior in this case is unchanged; the transaction will abend with system code AEIJ -
NOSTART. This failure cannot be handled by the application.

3193283 (1117153)
• For regions that are not TRANCLASS-enabled, the EXPIRYINTMIN attribute of the TSMODEL resource

is now supported. In addition, the LASTUSEDINT option is now supported on the INQUIRE TSQNAME
and INQUIRE TSQUEUE commands. Note that this changes the queue control record and will affect
any existing queues that were created with earlier versions of the product (affects non-TRANCLASS
regions only). As a result of this, you need to cold start the Temporary Storage and Transient Data after
applying this Patch Update. You also need to cold start any PACs that have existing TS\TD queues.

Enterprise Server Common Web Administration

Back to the list

• By default, ESCWA now runs on port 10086.
• When using the Vault Facility, the ESM passwords are now accessed by the ESM’s Universal Unique

Identifier (UUID) which makes the key for the vault. If this UUID cannot be found it uses the old name
based mechanism as the key for the vault. Note: All new ESMs have a UUID that conforms to 4122
RFC. The earlier ESM UID standard is still supported.

• PAC names are now limited to eight characters or fewer in ESCWA.
• The default ESCWA configuration file now sets ESCWA to run in loopback-only mode.

Enterprise Server for .NET

Back to the list
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• Previously, it was difficult to programmatically detect an error condition in the PowerShell commands for
Enterprise Server for .NET. The commands will now throw exceptions in the event of an error.

3187426 (1116657)

Enterprise Server Security

Back to the list

• The MLDAP ESM Module for Enterprise Server now interprets the ".**" wildcard sequence in a manner
closer to that of mainframe RACF. This behavior is configurable. See "Wildcards for Resource, User,
and Group Names" and "MLDAP ESM Module Custom Configuration Information" in your product Help
for more information.

3206992 (1118359)

File Handling

Back to the list

• The supervisor password is no longer displayed when cobfsclose is executed from the command line.

3195772 (1117571)
• Usernames in the Fileshare password file are no longer obfuscated; they are shown in plain text.

3120656 (641976)
• Fileshare can now read a password file stored in the Vault Facility. Use the /uv option when starting

Fileshare to read the specified password file from the vault. Note: You must have uploaded the
password file to the vault before starting Fileshare.

• The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

3217597 (1119504)
• The calculated output length of SORT and the memory required could be calculated incorrectly when

symbols were used.

3203471 (1118031)

• File and folder names that are deployed to PostgreSQL datastores are now case-insensitive. This
ensures consistency of behavior with DB2 and SQL Server datastores.

Handling of anonymous root field in JSON

Back to the list

For JSON (RESTful) service interfaces, the IMTK no longer forces the outermost (root) structure of a JSON
message body to always be a JSON object, but now also supports a root JSON array or primitive. Though
the root is obligatorily nameless in the JSON message, in the Interface Mapper the anonymous root must
now be defined in the operation's interface fields as the top-level body field. Consequently, since there
cannot be more than one input top-level body interface field nor more than one output top-level body
interface field in an operation, all interface fields that appear in the body of a message must now be
children of the top-level body field. Any non-conforming pre-6.0 JSON service interface is still supported
as-is, but conformance would be required upon any modification in the Interface Mapper.

HCO for DB2 LUW

Back to the list

• There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.

3204413 (1118115)
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IDE

Back to the list

• In fixed format COBOL code, lines in custom code snippets will now be automatically wrapped if they
reach the end of area A/B.

3201628 (1117874)
• Server Explorer in Eclipse and in Visual Studio now requires you to specify user names and passwords

if security is enabled to connect to the nodes. The default credentials are no longer automatically
applied.

JCL Support

Back to the list

• The wrong Symbol value was used when a symbol was assigned a different value following a
procedure.

3223719 (1119901)
• When replacing symbols in in-stream data, space-separated elements will be taken into account, and if

possible, the original position will be maintained.

3222942 (1119802)
• An issue where procedure COND statements were applied to the wrong procedure steps when the

procedure was called multiple times, notably the steps from the first call to the procedure when they
should be applied to steps from the specific call, has been resolved.

3222081 (1119699)
• The JCL JOB JOBRC parameter is now honored, and the correct return code set for the job.

3218927 (1119420)
• The MFFTP LCD, MGET and MPUT commands have been enhanced to process the members of a

partitioned data set.

3216865 (1119242)
• The removal of datasets with DISP=NEW because MF_UCC11=YA or MF_UCC11=M is set has been

restricted so that the DSORG, if defined on the DD Card, must match the catalog attribute. The removal
of a GDG Base by this method is prohibited. If the dataset cannot be removed and recreated, an error
message JCLCM0200S is issued.

3216471 (1119195)
• You now receive a correct error code, if an error occurs while processing the TSO RENAME command.

3215386 (1119281)
• The JCL File Action exit, MFJFAXIT, is now notified of the deletion of cataloged data sets.

3212961 (1118856)
• A problem in the public catalog API, mvscatpb, where the LRECL values for variable length files were

not validated correctly, producing false errors, has been corrected. The API will now return the catalog
record that has been changed.

3212769 (1118940)
• The incorrect changing of a VSAM data set file status from pristine to used when REPROing an empty

data set has been corrected. When REPROing records into a data set, if the source data set is empty,
the destination data set is not opened.

3212733 (1118839)
• GDG restart information is usually created only when ES_JES_RESTART=Y and MF_UCC11=Y or M;

however, by setting environment variables GDG_RESTART_UCC11_ONLY=N and
ES_JES_RESTART=Y results in the restart information for GDGs to be created. This ensures that the
dynamic setting of MF_UCC11, via the MFJUXIT user exit, can be applied to GDG versions. The
MFJUXIT user exit has been enhanced to provide a new event call, event-job-restart, which is called
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when a job is restarted, and provides the option for the user exit to be notified of future event calls - one
of which is ‘event-job-ready’, where the user exit can set the MF_UCC11 value for the job (see
mfjdxit.cpy for user exit event information).

3207134 (1118753)
• If a JOB CARD includes a USER ID and a PASSWORD that are different from the ones for the user

submitting the job, the credentials specified in the JOB CARD will be used to validate the permissions to
submit a job in place of the surrogate user.

3207055 (1118326)
• LISTDS now returns 8 if the requested dataset does not exist. Previously, it would return zero.

3204627 (1118102)
• PDS directories (PO) identified by environment values (the path to the directory starts with $<ENV-

NAME>), are now removed in the same way as those that do not use an environment value. The last
member is removed and the directory is empty.

3196118 (1117345)
• The MFJPTPCH module now supports the PREFORM and CNTRL parameters.

3194158 (1117171)
• Using MFFTP, a GET request that used SENDEOL no longer attempts EOL processing if the file is not

found. This now emulates the behavior on the mainframe. Previously, processing would cause
unexpected errors in cases where the file was not found.

3192989 (1117084)
• If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened

during the JCL step it is assigned to, then the updated catalog properties are not written at the end of
step disposition processing.

3186942 (1116611)
• It is now possible to export symbols from Enterprise Server and to use them in in-stream data. You can

also pass symbols on jobs submitted using the Internal Reader.

3164066 (1114816)
• When trying to export entries from a catalog that does not exist, mfcatxml will now report an error and

exit with a value of 12. Previously, it returned zero and created the catalog.

• An issue with error conditions incorrectly carried forward from one VSE job to the next one has been
resolved.

3220394 (1119913)
• The length of a SYSIN is no longer being checked unnecessarily.

3201488 (1117900)

Micro Focus Batch Scheduler Integration

Back to the list

• When running against an Enterprise Server PAC environment, mfbsijcl could return an invalid return
code to the scheduler. This has been resolved. Note that both of the following environment variables
must be present in the mfbsi.cfg configuration file in order for mfbsijcl to work with the Enterprise Server
PAC environment: ES_PAC and ES_PAC_ENDPOINT.

3215408 (1119254)

Micro Focus Directory Server

Back to the list

• UNC paths are no longer supported when importing or exporting to MFDS by default. To re-enable
them, set the environment variable MFDS_ALLOW_UNC to 'Y'.
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National data items in .NET COBOL code

Back to the list

.NET COBOL code that uses IS NUMERIC tests on NATIONAL or NATIONAL NUMERIC data items, or
uses NATIONAL NUMERIC data items in programs compiled with the CHECKNUM Compiler directive
must be recompiled in this release. Compiled code from earlier products that uses such constructs will
generate a MissingMethodException error when run under this release.

PL/I Support

Back to the list

• A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected.
This problem was limited to structures where the last member field was of type BIT. Specifically, the
problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member
field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the
point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame
allocation for the declared structure. Naturally, any module affected by this problem needs to be
recompiled. To ensure that no problems arise, the user should identify all modules that use a structure
or structures where the last member is of type BIT, and recompile those modules. This applies to users
who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT
means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.

3192381 (1117048)
• The macro preprocessor loop no longer occurs when there is a "DO" statement with "BY" and without

"TO". For example, statements such as "DO J=1 BY 1" are treated as infinite loops.

3216391 (1119216)

Run-Time System

Back to the list

• Previously, the value of the fill character and the option to use it were ignored in the RM window control
block. With this fix, the character will be used if Dialect"RM" is set and an appropriate ADISCTRL
configuration is used.

3138692 (1112552)

SQL Option for DB2

Back to the list

• The XDB Service name has been shortened.

3195822 (1119897)

VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when
ODOSLIDE in effect

Back to the list

If your Working Storage contains a data item with the OCCURS DEPENDING ON phrase, and ODOSLIDE
is in effect, any subsequent data items at the same or higher level must not contain a VALUE clause. If they
do, an error (COBCH1962) is now generated.

If you cannot remove the VALUE clauses from your source code or remove ODOSLIDE, contact
SupportLine.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• An issue with Microsoft's Visual Studio 2019 version 16.8 or later affects .NET Core COBOL projects
created with version of Enterprise Developer earlier than 6.0 PU4. To avoid the issue, install Enterprise
Developer 6.0 Patch Update 4 or later with Visual Studio 2019 version 16.8 or later.

• When debugging containerized Enterprise Server Application projects in Visual Studio, the .car file may
not get deployed to a running container after an initial debug session. This means that any code
changes may not get deployed. To work around this, you need to manually do a rebuild of the project to
force the container to be recreated with the latest changes.

• When using Debug > Attach to Process in Visual Studio to debug a process that is running, if you
detach from the process and then attach to the same process again, a protection violation might occur.

• In Enterprise Developer 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur
with running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, then executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Enterprise Developer 6.0, the .NET COBOL and JVM COBOL run-times
reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version 5.0 or
earlier of the product. You receive a "missing method" exception. To resolve the issue, you need to
recompile any programs that use this construct in Enterprise Developer 6.0.

Program that do not use NATIONAL data, or those that have been recompiled in Enterprise Developer
6.0 are not affected.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• Character Animator
• Code Analysis
• Code Coverage
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Debugging
• Dialog System
• Dockerfiles
• Documentation
• Enterprise Server
• Enterprise Server Auditing
• Enterprise Server Common Web Administration
• Enterprise Server for .NET
• Enterprise Server Security
• File Handling
• Form Designer
• Header-to-Copy Utility
• IDE
• Interface Mapping Toolkit
• IBM Language Environment for OS/390 & VM Support
• Licensing
• Micro Focus Common Client
• Micro Focus Directory Server
• MF Server Administrator (GUI)
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Unit Testing Framework
• IMS Support
• JCL Support
• PL/I Support
• REXX Support
• Run-Time System
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: Mainframe Batch Database Tools
• SQL: OpenESQL
• SQL Option for DB2
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• XML Support

Adis

Back to the list

• A single field is no longer padded to the right when the SIZE clause data-name is greater than the PIC
clause and all the other fields have the PROTECT attribute.

3223862 (1119916)
• An ACCEPT on SECURE fields no longer produces unwanted characters.

3221450 (1119807)
• Using JUST and ZERO-FILL in a CONTROL clause with ADISCF option 16 set to 3 no longer causes

an RTS 114.

3198021 (1117521)
• ACCEPT ON ESCAPE KEY and ACCEPT ON ESCAPE data-item now return the correct key-code in

RM/COBOL for function keys and escape. Note that the complete list of the returned key codes are not
100% compatible with RM/COBOL for all keys.

Assembler Support

Back to the list

• A problem that caused Swedish national characters to display as line drawing characters has been
fixed. Filenames with accented characters now display correctly.

3204665 (1118779)
• Errors produced by unsupported Assembler syntax have been corrected by an update that allows

addition or subtraction of character literals to match IBM Assembler behavior. The EBCDIC value of the
literal is now added or subtracted from the value of the relocatable data item. For example: TR
CHARTAB(32),=C'0123456789ABCDEF'-C'0' now assembles without error, and generates mainframe-
compatible object code.

3204543 (1118137)
• A BRNZ instruction generated incorrect machine opcode. The BR (branch relative) and BR..L (branch

relative long) extended mnemonics were placing the condition mask nibble in the fourth nibble of the
instruction instead of the third nibble resulting in incorrect behavior at execution time.

3197056 (1117444)
• A problem that produced invalid expression errors when substring notation in AIF macro statements

used an asterisk ('*') for length (for example: AIF ('a string'(5,*) NE 'EI').EXIT) has been fixed.

• A problem that caused an assembler program to be identified as CICS based on a user-written macro
named 'EXEC' has been corrected. Programs are now identified as CICS only when 'EXEC' is followed
by 'CICS'.

3182606 (1116316)

• The Assembler LE/370 prolog and epilog macros, CEEENTRY.MAC and CEETERM.MAC respectively,
have been rewritten to be more mainframe compliant. While this new base-level functionality is sufficient
for most LE/370 assembler application requirements, some features, such as NAB (Next Available Byte)
emulation, are not included in this fix.

3221676 (1119641)
• On rare occasions, the user abend SVC 13 would generate RTS114 errors in the MF370ENG.DLL

module. The module now tests for invalid addresses.

3210918 (1118676)
• The CEEENTRY macro now uses a new NAB emulation feature implemented in the MFASM run time

module. NAB buffer areas and data structures now emulate the mainframe NAB LE/370 data structure.
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3203475 (1118026)
• The Assembler debugger was entering "zoom" mode under the Enterprise Developer CICS

environment. It now pops up and waits for user input.

3183858 (1116890)

• An issue in the MFASM generalized trace facility has been resolved so that you no longer receive an
RTS 114 error when GTF is enabled.

3207628 (1118370)
• The LE/370 prolog macro CEEENTRY.MAC has been modified to support the NAB (Next Available

Byte) control block. Note that fields in the control block are currently set to nulls.

3191776 (1117022)

Character Animator

Back to the list

• A Perform Step of a CALL statement in INT code, after using the Do function, and then changing the
execution point with the Reset function, now steps over the CALL correctly.

3222172 (1119750)
• When detaching the debugger from a process on Solaris, the process no longer crashes.

3213587 (1118926)
• Two new command line options for Animator can be used to speed up the Animation of coredumps for

applications with a large number of programs. Specifying these new options "FASTLOAD" and
"FASTEXIT" on the command line will result in Animator starting and stopping significantly quicker. See
the documentation for details on these new options.

3212276 (1118852)
• CBL_EXIT_PROC routines can now be debugged correctly.

3208380 (1118433)
• Querying an OCCURS ... DEPENDING ON ... where the item is zero is now treated as an invalid query

and the item is not shown.

3201182 (1117795)
• When zooming and using Perform Step/Out over applications with many programs which have many

COPY statements, performance is improved.

3197159 (1118692)

Code Analysis

Back to the list

• A change has been made to allow DFHEIBLK to appear as an input and output parameter to extracted
components created in Logic Analyzer.

3226429 (1120119)
• If you wish to perform component generation using CICS, find the CICSSlice option in the project

options file (Options.Project.xml or p00000X.xml) and change VALUE="false" to VALUE="true". After
the regeneration, you will get instead of a CALL statement an EXEC CICS LINK PROGRAM statement.
If the CICSSlice option is left in its default state (false), the generated slice will include in the generated
structure BRE-INP-INPUT-STRUCTURE the DFHEIBLK members.

3226425 (1120121)
• The structure slice no longer generates unnecessary copybooks.

3226424 (1120105)
• Display statements now support the vertical bar symbol (|).
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3217022 (1120020)
• If a project contained source files that were included as part of a linked folder, sometimes the resolved

location of those files was being corrupted, and so the code analysis functions could not execute
correctly. The required paths are now passed correctly to the compiler.

3207365 (1118363)
• An issue in Logic Analyzer where comments may not be deleted from an extracted component source

file has been fixed.
• An issue that caused incorrect code generation for variable-formatted COBOL in Logic Analyzer has

been fixed.
• An issue caused by the checker not generating end coordinates for the FILE SECTION in the

kenlygen .xml file has been fixed.
• An issue where the REPLACING clause would sometimes be omitted from a COPY statement in code

generated by Logic Analyzer has been fixed.
• An issue where Logic Analyzer could generate syntactically-incorrect code when processing free-

formatted COBOL has been fixed.
• An issue with fall through in Program Control Flow when the program has multiple program entries has

been fixed.
• An issue that could cause an abend on some Logic Analyzer extraction operations has been fixed.

Code Coverage

Back to the list

• Test Coverage result files containing results for different programs can now be merged correctly by the
IDE.

3202218 (1117937)
• The tcreport tool (or cobtcreport on UNIX) no longer requires write permission for the .tcz test coverage

results files it reads.

3197117 (1117439)

Common Communications Interface

Back to the list

• When CCI shared memory was processing multiple simultaneous broken connections and data at the
same time, it was possible that the data could not be read.

3195698 (1117370)
• ssltrc.txt is no longer created with an extra character in the file extension.

Communications Server

Back to the list

• In order to mimic mainframe behavior a new CWI option has been added called "Always send options".
The default is 1 and will maintain current behavior of always sending a HTTP options request when
performing a CWI Open command. When set to 0 it will only send a HTTP options request as part of the
CWI Open if either HttpVNum or HttpRNum are specified.

3218438 (1119912)
• A number of reflected Cross-Site Scripting (XSS) vulnerabilities have been addressed in the http-echo

conversation module for Enterprise Server. Note that this module is not enabled by default.

3198822 (1117729)
• Configuration information is no longer displayed in log.html when a new connection is made with the

TN3270 listener.

3185279 (1116510)
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• The mfpackage utility can now undeploy REST services.

3100111 (1108820)
• The Micro Focus zip library has been renamed from zip.dll/libzip.so to mfzip.dll/libmfzip.so, due to

conflicts with other similarly-named libraries. This should not affect customer applications but will allow
some customers to discontinue workarounds they had applied for these conflicts.

2864796 (1105391)
• There are no longer issues with setting some of the TLS (SSL) listener options in Enterprise Server.
• The Enterprise Server Communications Server (MFCS) now uses the same paths as the DemoCA

scripts for the default locations of the server certificate and key files. If you use DemoCA (recommended
for development and test purposes only) to create any key and certificate files for Enterprise Server
listeners, you can specify those using unqualified filenames (such as "srvkey.pem" and "srvcert.pem") in
the listener configuration.

• Enterprise Server now sets a Content Security Policy for HTTP responses that contain HTML code as
well as for some responses that contain plain text (to avoid false positives from web scanners). This is
to help prevent possible security exposures should new vulnerabilities in HTTP processing be found.

• The Enterprise Server service installation utility mfdepinst now accepts various command-line options
for configuring the installation process.

Compiler

Back to the list

• A new Compiler directive, DPC-IN-DATA, enables you to control whether the DECIMAL-POINT IS
COMMA clause (if specified) is applied to the output from the XML GENERATE and JSON GENERATE
statements.

3225204 (1119993)
• Multiple undefined data items in the same statement are now all correctly detected and reported as

such.

3224326 (1119891)
• STRING <national/DBCS-item> WITH POINTER no longer gives incorrect '1045-W Capacity of

POINTER may be exceeded' warning message.

3224231 (1119879)
• Programs with data items that have a REDEFINES clause and are defined from typedefs now compile

as expected with the INIT-BY-TYPE directive.

3224059 (1119884)
• A JSON PARSE statement will now accept a null value when the associated COBOL item is a group

structure. The whole group will remain unchanged, with parsing continuing (with a non-exception json-
status code).

3222416 (1119788)
• Programs that contain XML or JSON statements now compile as expected with the MF(19) Compiler

directive.

3220175 (1119526)
• The compiler will now give an error message if the class condition IS NUMERIC is used on a PIC G

variable.

3219148 (1119408)
• A multi-program source which contains a very large number of programs now compiles as expected and

no longer produces spurious messages about memory issues.

3218772 (1119405)
• An XML GENERATE statement in a native OO program which requires the use of the

REPOSITORY(UPDATE ON) directive, now generates correct xml output with the case of names
preserved from the one specified in the source.
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3217436 (1119293)
• Project that use stacked preprocessors, including prexml and cobsql, now show the correct colorization

and copybook dependency information following multiple background parse operations.

3217164 (1119270)
• The length and byte-length intrinsic functions can now accept pointers and index-names as arguments,

as described in the product documentation.

3216240 (1119197)
• Intrinsic functions such as ABS, SIGN, EXP and EXP10 are now supported under the ENTCOBOL

dialect which emulates IBM's latest Enterprise Cobol release.

3215473 (1119088)
• A COMPUTE statement which followed a statement referencing a boolean data item now compiles as

expected, without giving an internal error.

3215314 (1119160)
• A data name immediately followed by an opening parenthesis of an abbreviated condition now compiles

successfully.

3210121 (1118623)
• Compilation of statements which reference floating-point fields with nested subscripting now produces

correct object code, and executes as expected.

3209711 (1118555)
• A report file that does not have a record definition, and specifies a RECORD CONTAINS clause of

larger size than the value of the REPORT-LINE directive, now produces correct report output.

3208971 (1118489)
• An inline method invoke passing a numeric literal to an ANY LENGTH parameter is now working as

expected.

3206678 (1118306)
• Filenames that contain Swedish characters now appear correctly in the Visual Studio error output. This

enables the subsequent error location to work correctly.

3204665 (1118778)
• A JSON GENERATE statement with a NAME clause which renames a group item in the generated json

to the value of a 78 item now compiles and executes as expected.

3204281 (1118109)
• The N symbol type for VALUE clauses of 88 levels associated with a NATIONAL data item is now

correctly inferred to be NATIONAL. (The preferred solution, however, is to set NSYMBOL(NATIONAL)
correctly.)

3204277 (1118077)
• Provide a directive DISPLAY-AT(foreground-color background-color) to specify default colors for any

ACCEPT or DISPLAY AT which does not already use a color clause. See the directive entry in the
documentation for more details.

3201040 (1119380)
• COBOL words that include non-standard characters rejected by IBM's Enterprise COBOL are now

similarly flagged under appropriate mainframe dialects.

3199487 (1117690)
• A UTF-8 source with the currency-sign set to the Euro symbol now compiles as expected, provided the

file has a byte order marker or the ENCODING(UTF8) directive has been specified. (Note in Visual
COBOL/Enterprise Developer the directive is now called SOURCE-ENCODING.)

3199087 (1117629)
• Mainframe behavior concerning what syntax is allowed prior to a REDEFINES clause in a data

description entry is now better emulated under a mainframe dialect.
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3195091 (1117380)
• A VALUE clause on an item defined via a typedef and compiled with the INIT-BY-TYPE directive now

compiles as expected.

3194326 (1117195)
• A DISPLAY statement which uses the DISPLAY-OF intrinsic function and is compiled with the

CHARSET(EBCDIC) Compiler directive, now produces the expected run time results.

3191395 (1117115)
• An ADIS DISPLAY of national data now executes as expected.

2666775 (608918)
• Previously, when profiling code, if control trickled through a GO TO DEPENDING because the value of

the index variable was out-of-range, time could be counted against the wrong paragraph.

• In generated code, on all platforms except Intel x86 32-bit, a very simple program (that is, one with no
calls, file handling or display operations, or any complex operations) that specified DBSPACE"mixed"
could give the wrong result or a 114 run-time error.

3218551 (1119351)
• An internal logic error could occur within the NCG when compiling deeply nested IF statements (more

than 16 levels deep) in a program compiled with DATA-CONTEXT or PIC. This could only happen on
Intel x86 platforms and with 32-bit generated code.

3218376 (1119347)
• A bug in the Intel x86 32-bit generated code for statements of the form: multiply -1 by x where x is a

COMP (including COMP-4) item and the TRUNC directive specified, has been fixed.

3199580 (1117691)
• A bug in generated code has been fixed, where COMPUTE statements containing terms of the form:

function numeric-function(args) * 0 where numeric-function is any numeric intrinsic function, could have
unpredictable results at run time.

• If ERRLIST(END) was used together with ILSOURCE, all the errors for all the programs were listed with
the listing for each program. Now only those errors which relate to a single program are included in the
listing for that program.

3225341 (1119990)
• In previous versions of the product, warnings COBCH0656W and COBCH1151W could be produced for

PIC 1 fields with USAGE BIT, in cases where such warnings were inappropriate.

3223726 (1119819)
• Bad code was generated for a constructor that has at least one COBOL-style parameters (such as PIC

X or group linkage records) and at least one .NET native parameter (such as an object or a primitive
type such as binary-long).

3221048 (1119581)
• If an INITIALIZE statement referenced a group with the OCCURS clause (or subsidiary to another group

with an OCCURS clause), and if that group contained PIC 1 USAGE BIT data, then if the INITIALIZE
statement was specified with a non-literal subscript, the Compiler would produce system errors. This
has been resolved.

3219949 (1119477)
• In previous product versions, with programs compiled for .NET or JVM and using the INDD or OUTDD

directive, if the SYSIN or SYOUT variable was not set, or pointed to a non-existent file, no error
occurred when an ACCEPT or DISPLAY statement was executed. In this version a run-time error is now
produced when the first ACCEPT or DISPLAY statement is attempted.

3219143 (1119406)
• Invocations to specific generic overloads within a super class, where multiple overloads exist with the

same parameters, now compile successfully.
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3215786 (1119127)
• If a program included an invoke statement with a parameter requiring an implicit conversion, compiling

with the RVGEN directive could cause the compiler to crash. This could occur if the program was a
WinForm program loaded into Visual Studio.

3214005 (1118981)
• Previously, with PERFORMTYPE"RM" in effect, and when an ECM preprocessor was in use, a STOP

RUN at the end of the user program could sometimes cause the compiler to crash with an error 114.
This is now fixed.

3213280 (1118885)
• Bad code was produced when OCCURS appeared in a screen section item, which also has a LINE or

COLUMN clause referencing another table with OCCURS.

3211797 (1118801)
• When compiling a multi-program source unit for managed code (by using the ILSOURCE directive, or

through an IDE project with multiple source files), the listing for the individual sources did not always
indicate the correct number of errors/warnings. This has now been fixed.

3211333 (1118701)
• When compiling for .NET or JVM, the SAME RECORD AREA clause was not always effective.

3210757 (1118644)
• When compiling for .NET or JVM, a STRING statement involving both string objects and linkage records

could produce bad code.

3209650 (1118560)
• When a .NET project has a reference to an assembly, which itself has references to a dependent

assembly, and if the project does not have an explicit reference to that dependent assembly, error
messages of the form 'Failed to find system program 'EXTFH'' could be produced.

3200162 (1117797)
• You now receive a compile-time error if an attempt was made to access an object file (i.e. a file in a

class program defined without the STATIC qualifier on the FD) from a static method. Previously, this did
not result in an error at compile time, but instead produced an invalid program that failed to load at run
time.

3196233 (1117354)
• For a program compiled to .NET COBOL code using the CHECKNUM directive, a MOVE statement

from a numeric DISPLAY field to a numeric edited, where the source contained non-numeric data, was
not producing an error 163. With this release, an error 163 is produced.

3194570 (1117200)
• Conditional expressions are now allowed as method parameters. This requires that the new directive

ILCONDITIONPARAM is set to ON (which is the default). Specify NOILCONDITIONPARAM in order to
maintain compatibility with the old way of specifying named parameters to custom attributes.
Alternatively, change your code as in the following example from: custom-attribute is type
WebServiceBindingAttribute("Name"="ShakespeareSoap", "Namespace"="http://xmlme.com/
WebServices") To: attribute WebServiceBinding(property Name = "ShakespeareSoap", property
Namespace ="http://xmlme.com/WebServices")

• Under DotNetCore (.NET Core) support, if HOSTFD is enabled, reading an index file with a record area
less than is expected by the index file could result in a memory corruption. This has been fixed.

Data Tools

Back to the list

• The dfconv command line utility now supports a new option "-s" - this option skips DBCS checking
during conversion, in order to improve performance. This option should only be used from within a
DBCS locale, and only when you are sure that the data you are dealing with is from a SBCS.
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3213092 (1118872)
• When running the DFCONV command line batch interface, a new option -F (or -f) allows only the fixed

text output to display; no dynamic updates are displayed to the console after each record is processed.

3163542 (1115730)

• Trying to open a PDS file in DFED no longer results in out-of-bounds exceptions.

3214578 (1119499)
• Structure files can now be loaded and unloaded after a data file has been opened.

3181265 (1116352)

• Conditional structure now work with EBCDIC files where the condition field is not at the beginning of the
record.

3204158 (1118166)

Debugging

Back to the list

• When animating programs where the source name differs from the program name, breakpoints are now
set correctly.

3210556 (1118743)
• Attaching the debugger to a running process is now quicker than previously.

3198107 (1117569)
• When zooming over applications with many programs which have many COPY statements,

performance is improved.

3197159 (1117509)

Dialog System

Back to the list

• The Export process in Dialog System no longer fails with RTS164 error.

3200921 (1117781)

Dockerfiles

Back to the list

• esadm is the default user for all the different container images.

Documentation

Back to the list

• The K4 switch is now correctly documented in the Visual Studio-related products.

3219902 (1119948)
• The documentation has been updated to explicitly state that the FOLDER tag, used in extfh.cfg, only

supports the use of local folders; it does not support the use of networked folders.

3212247 (1118782)
• The documentation has been corrected in relation to the supported data types allowed in a stored

procedure definition file.

3207946 (1118435)
• The note at the head of the list of run-time tunables, stating that the tunables are for native code only,

has been removed. Any native-only restrictions for tunables are mentioned in the topics of each tunable.
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3207815 (1118381)
• The error message description for the warning message COBCH1237 has been corrected. It also now

contains a link to the Compiler directive topic (REENTRANT) that it relates to.

3205344 (1118169)
• The cbllink option -s has been correctly removed from the documentation.

3200100 (1117719)
• To create an EXTENDEDESDS file, the docs now state that you must use a combination of

IDXFORMAT"15" and the EXTENDEDESDS option.

3195595 (1117298)
• The syntax diagram for indexed file formats (format 4) has been updated in the documentation - topic:

The File Control Entry. It now indicates that WITH [NO] DUPLICATES can be specified on the record
key, as an MF extension.

3177534 (1115898)
• The documentation on the FILE_TRACE configuration variable (used within Database Connnectors)

now includes details on the level of tracing that is possible.

3164533 (1117209)
• The Restrictions that appeared on all IMTK topics indicating that the topics applied to Windows (local

development) only have either been removed or updated to reflect Windows only.

3164533 (1115095)
• The RM/COBOL compatibility documentation now makes it clear that the DIALECT"RM" directive

should not be applied to managed COBOL.

3139755 (1112643)
• The documentation now includes the sequence in which the Run-Time System will attempt to locate a

requested .lng file - see 'Compiling and Deploying a Message File'

2869115 (1106127)
• Clarification has been added to the documentation about the VISUALSTUDIO Compiler directive. It is

reserved for internal use, even though it appears on the directives settings list.
• The context-sensitive reserved words, particularly those relating to the ACU dialect, have been

relocated to the Context-Sensitive Reserved Words topic. (They previously resided in the Reserved
Words Table topic.)

• The explanation of parameter prefix substitution in the MFBSI configuration file has been clarified in the
documentation.

• The 'Unit Testing from the Command Line' section of the MFUnit documentation now contains a list of
possible error codes generated when running tests from the command line.

• The documentation has been updated to clarify the default behavior when the ALIGN directive is
specified without either OPT or FIXED.

• The documentation for the Micro Focus Database Handler now clarifies when a region and cross-region
database is required (in the Configuration Requirements section).

• The sample code listed in 'Typedef - User Defined USAGE or Structure' has been corrected.
• The procedure for installing Enterprise Developer for Visual Studio into an offline environment has been

updated. See 'Installing Enterprise Developer in an Offline Environment' in the product documentation.

(643830)
• The documentation has been corrected for the TYPEDEF clause - the list of clauses not permitted for

use when TYPEDEF is specified is now accurate.
• Details of how to configure a specific run-time environment (using an application.config file) for .NET

tests run from Visual Studio has been added to the documentation.

(643605)
• The documentation has been updated to state that the maximum number of PERFORM ranges in a

program (65535) is also applicable to .NET and JVM COBOL programs.
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• All erroneous references to the TRUNC, BS2000-OFFLOAD, and INFORETURN directives have been
removed from the documentation.

3223245 (1119786)
• All erroneous references to the FLAGCD directive have been removed from the documentation.

3223242 (1119785)
• All erroneous references to the [NO]OLDSTRSUB directive have been removed from the

documentation.

3223240 (1119783)
• The documented example for the mf.mfdbfh CTF component now contains the correct settings in order

for the trace to be successful.

3203127 (1118015)
• The documentation has now been updated with the correct definition for the CCITCPS_fsname variable,

used within Fileshare.

3192544 (1117368)
• The DD Statements topic has been updated to include correct values for XTEP2 and its alias

DSNTEP2.

3168080 (1115120)
• The Interface Mapping Toolkit topic under Known Issues and Restrictions has been updated to clarify

support for the ODOSLIDE compiler directive.

3152222 (1113733)
• The documentation now correctly states that the CBL_CREATE_CORE library routine is for native

COBOL use only.
• Ensure that you back up your secrets configuration file, secrets.cfg. Before you install a new version of

your product. By default, the secrets.cfg file is located in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\etc (Windows) or $COBDIR/etc (UNIX) directory. Restore the backed up
configuration file once the product installation is complete.

3216092 (1119162)

• The documentation now includes details of the MFJ_STRICT_CASE environment variable, which can
be used to maintain the case of physical file names passed to MVSCATIO by the catalog API, and other
utilities.

Enterprise Server

Back to the list

• TS queues that were created with an expiry interval and stored in Redis would have their expiry interval
corrupted when a subsequent READQ TS was performed on that queue. The expiry interval is no
longer modified during the life of the queue.

3221103 (1119598)

• In a PAC, when a JES initiator was terminated, if the job was in the Dispatch queue the lock was not
removed for the dispatch queue SYSZJOBD.

3226274 (1120084)
• It is now possible to use casfile -p to change the current path of a closed file or, if the file is cataloged, to

change the DSNAME from the specified DD NAME.

3224800 (1119969)
• An issue causing an RTS 114 on DFSRRC00 related to disabled xa entries has been resolved.

3223838 (1119845)
• You can now set the environment variable ES_PAC_NO_GLOBAL_LOG=Y if you do not want all the

messages from all console.log files for all the regions in a PAC to be stored in the PSOR CasPacLog.
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3222549 (1119714)
• CICS Web requests greater than 32 Kb to secure regions no longer incorrectly receive a 403

(Forbidden) response.

3222308 (1119752)
• Switching on the active HSF file could cause a thread in the castrc process to go into a tight loop and

use a lot of CPU.

3219692 (1119546)
• Enterprise Server was always attempting to verify if a called program was a PL/I one or not even when

the PL/I option was not active for the region.

3219147 (1119409)
• A MalformedResponseException error when using channels and containers on ECI calls has been

resolved.

3217992 (1119653)
• Strings with special characters were sometimes being truncated or causing a malformed XML error. The

whole string is now being returned without any truncation or errors.

3217170 (1119681)
• A CCSID Error 0002 could occur when converting certain strings to UTF-8, if the strings contain

characters that expand from single to multi-byte during the conversion. The reason for this was that the
converted string was longer than the maximum length specified for the field. Instead of resulting in an
error, the data is now truncated. This matches the behavior on the mainframe.

3217170 (1119262)
• The Historical Statistics Facility (HSF) post-processor utility casfhsf has been enhanced to output time

intervals of from 1 to 9999 seconds. An option is now provided to optionally split the date/time output
column into a date column and a time column. The maximum number of columns has been increased to
172,800 for 32-bit systems, and to 1,296,000 for 64-bit systems. The number of transactions within an
interval that meet its specified system response time criteria is now reported correctly.

3214504 (1119179)
• Calling into an entry point on an already loaded program no longer causes memory leaks.

3214021 (1119003)
• An empty XML element in the SOAP response message no longer results in an ARRAY_TOO_SMALL

error.

3212477 (1118802)
• Tranclass MaxActive is now honoured in PAC configurations.

3209901 (1118571)
• Micro Focus now supports IBM's GMTRAN system initialization parameter in CICS SIT, which enables

you to disconnect a CESN transaction. GMTRAN enables you to specify the outcome of pressing F3 or
CLEAR on the CICS Signon transaction CESN/CESL. This is either EXIT (the default) or DISCONNECT
(disconnects the TN3270 terminal from the region).

3209820 (1118562)
• The command line help for casstart now includes information about the /m option.

3208071 (1118414)
• The initialization of a Service Execution Process could be interrupted by a request which provoked a

security call before the local ESM context had been established. This resulted in an error which would
cause the server to shutdown immediately. This has been fixed.

3208021 (1118431)
• An issue on a START TRANSID with TERMID executed from an EBCDIC program has been fixed.

3206507 (1118272)
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• The permissions for resources (such as TSQUEUE) were being checked every time they were used in a
transaction. Now they are checked once per transaction and the result of that check is used on
subsequent requests.

3206471 (1118690)
• All BATCHONLY MQ resource managers accessed from the same DSNRLI program are now security

checked. Note that DSNRLI is limited to opening only one MQ resource at a time.

3205339 (1118173)
• When running in a secure region, if USERID was specified on an EXEC CICS START command, the

target user and the rights of the user of the active transaction to operate as a surrogate for that user
were not being verified correctly. This resulted in the started transaction executing under the default
CICS user credentials. This has been fixed.

3204696 (1118150)
• A WEB HTTPHEADER command now returns INVREQ when used without a SESSTOKEN in a non-

CICS Web Server application.

3202999 (1118298)
• If one or more jobs had a shared lock on a dataset (DISP=SHR) and another job was waiting for

exclusive access (DISP=OLD) on the same dataset, the latter would be granted the lock when any one
of the other jobs completed. The file would not be available for exclusive use and this would result in a
9/65 error, file locked status on open. This has now been resolved and the exclusive lock is not granted
until all shared locks have been released.

3201463 (1117839)
• Previously, INQ TRANCLASS could fail and return a TCIDERR response code if CASTSC was handling

a heavy load.

3200414 (1117738)
• ITR requests (such as file requests) are not sent to the transient SEP running the EZASOKET CICS

transaction.

3200370 (1117767)
• Invoking any of the CAS* utilities (such as casout) against an enterprise server instance running on a

machine with a host name which exceeds 40 characters in length no longer results in a failure to find
the service.

3200011 (1117816)
• Previously, a high volume of events in the system could cause shared memory constraints. This was

because the system generated the events irrespective of what the event manager exits were checking
for. It is now possible to avoid this by setting the filter strings in the event manager exits. This ensures
that only the required events are generated and helps to avoid any further shared memory constraints.

3199174 (1117679)
• Previously, a high volume of events in the system could cause shared memory constraints. This was

because the system generated the events irrespective of what the event manager exits were checking
for. It is now possible to avoid this by setting the filter strings in the event manager exits. This ensures
that only the required events are generated and helps to avoid any further shared memory constraints.

3199174 (1117680)
• ESCERTPAS can now return spaces as the passphrase to allow for certificates that do not have a

passphrase.

3196872 (1117431)
• The following APIs are now supported: MQCRTMH, MQBUFMH, MQMHBUF, MQDLTMH MQSETMP,

MQINQMP, and MQDLTMP.

3196430 (1117373)
• The performance when accessing PPTs for a program that has already been invoked in the same task

has been improved.
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3195445 (1117554)
• In the case of OPERCMDS, you need to call the security exit only if the esm-input-parms pointer has

been provided. This helps to avoid receiving an RTS 114 error message.

3195205 (1117377)
• An issue where a process recovery caused the entire region to crash has been resolved.

3192471 (1117060)
• Sysout output from the casout utility larger than 64K is now displayed correctly on the screen.

3192406 (1117734)
• Previously, console.000 was always overwritten when console.log max size was specified.

3192214 (1117565)
• In MQ series support, the MQCSP block which can be passed on an MQCONNX call and carries user

credentials, was not being converted. This resulted in MQ connection failures.

3191698 (1117032)
• When an alternate user ID is supplied on an MQ call, it is now authorized against the server's active

ESMs.

3183523 (1117005)
• Under certain circumstances, a batch job which used EZSOKET calls could abend for exceeding its job

card's TIME parameter before that period had expired.

3181745 (1116242)
• The association of a XA switch module with a batch unit of work now returns an error if the XAR cannot

be associated. This change might affect DSNRLI, DSNALI, and TSO in Batch(IKJEFTxx) processing.

3178489 (1118208)
• The fixed transaction property for a terminal resource was not being honored correctly.

3176086 (1115790)
• An intermittent issue with SSTM jobs not running after the region has started has been resolved.

3175925 (1115789)
• An intermittent issue was introduced in 5.0 Patch Update 2 where CICS could release a SYSZDSN

ENQ prematurely at FCT close, before all SEPs had physically closed the file. If a batch job was waiting
on the same ENQ, it was possible that the job could get a 9/065 status on the file if it was accessed
prior to all SEPs completing the close. This has been fixed.

• HSF records following a date rollover are no longer intermittently recorded as occurring on the previous
day.

• An issue which caused a memory corruption on shutdown when using JCL HSF has been resolved.
• Hexadecimal prefixes can now be defined in Scale-Out Repository (SOR) models. See "PAC and SOR

Environment Variables" in your product Help for more information. A new exit, TSTDSRUE, has been
provided to determine whether or not to direct a TS or TD access request to a SOR at queue access
time. Usage of this exit causes any SOR models that have been defined to be ignored. See
"Configuring TS and TD Queues for SOR Storage" in your product Help for more information.

• The XML export of resource definitions now ignores any resources that are in groups that have names
starting with "DFH".

• A lock serialization no longer occurs on PAC Tranclass.

3222098 (1119677)
• A problem that occurred in castsc when running a transaction that had an unknown tranclass caused an

RTS114 error. This has been corrected.

3220668 (1119647)
• A crash could sometimes occur in an enterprise server in a PAC configuration under heavy load. This

has been resolved.

3220040 (1119490)
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• When using EXEC CICS START with DATA in a PAC environment, a memory leak could cause the SEP
to crash.

3218858 (1119389)
• Entries in the local PPT counters table were not being correctly removed, and the table was not properly

reduced in size when the extra space was no longer needed. These issues have been corrected.

3217950 (1119349)
• Latency displayed on the monitor page for transactions initiated using the START API showed as

incorrectly high. This has been corrected.

3215297 (1119128)
• Support has been added for the following TSMODEL attributes: REMOTESYSTEM REMOTEPREFIX

XREMOTEPFX RECOVERY(YES) Support has been added for the RECOVSTATUS option on the
INQUIRE TSQUEUE/TSQNAME commands.

3214937 (1119043)
• An issue with the processing of inbound QUEUE model requests flowing over APPC has been resolved.

You must upgrade the resource definition file for the new CSM3 transaction to be made available to the
system as part of the DFHISC group. To upgrade your resource definition file (dfhdrdat), execute the
caspcupg command.

3214659 (1119015)
• An RTS114 error that occurred when running an ESMAC DUMP while one or more channels were in

transit has been fixed.

3213819 (1119378)
• A problem that caused a TRANCLASS CLASS display request to intermittently return invalid characters

has been fixed.

3213819 (1119424)
• An issue where Dynamic XA processing, invoked by MFDS and CRCN, could result in connection loss if

the same switch was handling several connections has been resolved.

3212594 (1118814)
• On region shut-down, if CRCN was in the reconnect state, it would hang and the region would not shut

down.

3212564 (1118813)
• EXEC CICS INQUIRE ASSOCIATION is an unsupported API. Use CICSECM(FUNC=NOOP) for your

programs to compile.

3212245 (1119025)
• When a COMMAREA override was set, an RTS205 error occurred in started transactions compiled to

AMODE. This has been fixed.

3211712 (1118759)
• A problem that caused an intermittent NOSPACE error on WRITEQ TS has been resolved.

3204706 (1118216)
• When an EXEC CICS START specified a CHANNEL, memory was being allocated by the task

performing the start, but this was not being freed. If this was a long-running task performing many
STARTs, it was possible for the process to exhaust available memory. Storage housekeeping has been
improved to ensure that this no longer occurs.

3203094 (1118042)
• If an FCT for an alternative index was opened, and the primary FCT was subsequently opened in the

same task, the FCT file for the alternative index was left open after both FCTs were marked as closed.
This has been fixed.

3200676 (1117802)
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• The import and export process of resource definitions now takes into account all SIT cold start flags.

3196670 (1117418)
• Micro Focus ECI support now supports user IDs and passwords that are greater than eight characters

in length. See "Micro Focus External Call Interface" in the product Help for more details.

3195078 (1117382)
• HSF records for CICS transactions that are STARTed now have a valid latency value. Previously, the

latency calculation was disabled and would always be 1 for STARTed transactions.

3194297 (1117182)
• A data loss issue has been resolved where TRANCLASS is enabled and a read and a write transaction

for a protected Intra-Partition Transient data Queue commit concurrently.

3193323 (1117117)
• JSON data was being generated incorrectly when there was only one element in a JSON array item.

3192433 (1117035)
• When an internal PPT management table no longer has enough space to store its data a new larger

block is allocated. Previously this would result in the creation of a dump for diagnostic purposes.
Whether to generate the dump is now configurable using the environment variable ES_PPTL_DIAG=Y.
You should use this if you are instructed to do so by Micro Focus support.

3191382 (1117066)
• A problem that caused the Micro Focus Communications Server (MFCS) to fail when the application

sent 3270 control byte characters as data to the screen has been fixed.

3187441 (1116874)
• An additional option for nowait has been added to castran and CNCL. In the case of castran specify: !

castran -v<program>,nw! For CNCL specify: CNCL <program> NW

3182587 (1116313)
• The casfile /p parameter can now change the current path of a closed file or, if the file is cataloged,

change the DSNAME from the specified DD NAME.

• Security Fix: A vulnerability within ESMAC which made the Web UI more susceptible to reverse
tabnabbing has been removed.

3216053 (1119150)
• If MFDS_DNS_RESOLVE=Y is set, the resolved hostname of the requested address for a listener is

used for the ESMAC URL from MFDS, even if the listener is specified with an IP address in the listener
definition.

3194907 (1117388)
• Some issues with sorting jobs on the spool page have been resolved.

3194166 (1117179)
• ITRs are now routed to the target SEP via castsc.

3193937 (1117152)
• An issue with Reply to console page in ESMAC has been fixed.

3192888 (1117078)
• Spool SYSPRINT files stored in DB can now be viewed as expected. An issue where the file was

corrupted/overwritten when viewed in ESMAC has been resolved.

• The ESXDBOPC RM switch module has been updated to provide further clarification for optional open-
string customization.

3223990 (1119899)
• A new XA Switch build option - mssql17 - allows the use of the SQL Server ODBC 17.3 driver (and later

versions).

3220548 (1119748)
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• APPLNAME is now set when DSNRLI SIGNON is called with an argument.

3219384 (1119464)
• After a SRRCMIT/SRRBACK call, the connection is now being set correctly.

3218880 (1119427)
• The ODBC XA switch now initializes and starts correctly when MFDBFH is enabled.

3218343 (1119410)
• There is no longer an issue with running an XA job after cancelling an XA job in ESMAC.

3218095 (1119496)
• New functionality now enables you to store all or part of an XA open string in a vault using the Micro

Focus Vault Facility.

3217806 (1119289)
• The ODBC switch now handles IMS BMP jobs correctly when the BATCHONLY=T option is specified.

3212998 (1119040)
• XAR now uses the long username for connections during user impersonation if the new open string

option LNAME=T is specified.

3203042 (1117973)
• The XA module for XDB now builds without any issues in the Enterprise Developer 5.0 products.

3199440 (1117649)
• XA switch modules now recognize IMS transactions correctly.

3198981 (1117710)
• The DB2 XA switch module now handles user impersonation and the packagepath option correctly.

3166472 (1118325)

Enterprise Server Auditing

Back to the list

• Enterprise Server auditing no longer hangs if auditing is enabled for the External Security Facility but no
audit configuration file is present, and the Audit Manager is not running.

Enterprise Server Common Web Administration

Back to the list

• An issue with viewing regions in ESCWA using an MF Directory Server process secured with the Micro
Focus Internal Security has been resolved.

• When editing the IMS properties of a region in the ESCWA GUI, it was not possible to set the IMS
Codeset Bias to "ASCII" and the IMS Attribute Bias to "Binary".

• The ESCWA user interface now performs validation in the same was as the Enterprise Server MFDS.

3194067 (1117163)
• It is now possible to add a color to a directory server's region through its General> Appearance drop-

down list. This enables you to change the color of the region in the tree, and the background color of the
region's pages. This setting overrides the directory server's colors, if they were already set.

3132670 (1111980)
• It is now possible to add a color to a directory server from the server's General > Appearance drop-

down setting. Use this setting to change the color of the directory server in the tree, in the background
color of the directory server pages and all of its region pages.

2869809 (1105847)
• The Monitor > Properties page now displays the list of Pending Requests under counts. This represents

any type of pending requests for the region.
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Enterprise Server for .NET

Back to the list

• Enterprise Server for .NET now supports passphrases (long passwords) for signing on to CICS regions.
The PHRASE and any related options to EXEC CICS SIGNON are supported, and the CESL system
transaction is included. Use the seeupgrade utility to add CESL to existing region resource definitions.

3208682 (1118452)
• A reference to the ESDEMO region database no longer causes any issues when using a CICS-enabled

region other than ESDEMO.

3195019 (1117241)
• The CICS emulation BMS support in Enterprise Server for .NET now sets the field flags (Field-Empty

and Cursor-in-Field) as appropriate on RECEIVE MAP.

3192498 (1117038)
• Enterprise Server for .NET now supports DCAS (Digital Certificate Authentication Service) and ELF

(Express Logon Facility).

3192109 (1117037)
• Enterprise Server for .NET now supports setting user ID and password user credentials on EXCI

requests. The AspNetExciClient interface for invoking EXCI under IIS-hosted applications can now
automatically authenticate to an Enterprise Server for .NET CICS region using the client's user name as
determined by IIS authentication, and a passticket supplied by the DCAS service. Enterprise Server
for .NET now also supports configuring a user ID for HTTP-based requests, including CICS REST Web
services and EXCI. This feature provides an alternative to running them under the CICS default user ID.

3192042 (1117008)
• It is now possible to view and edit shareoptions in the Catalog view.

3191952 (1117002)
• It was not possible to open a file without shareoptions in a region which has shareoptions enabled.

3191687 (1117001)
• Enterprise Server for .NET CICS APIs now set EIBRCODE correctly when an error occurs.

3191686 (1116983)
• Enterprise Server for .NET with LDAP-based security was handling bind-mode Verify (user signon) and

the "user ID attribute" configuration setting. This has been corrected.

3126070 (1111318)

• The Enterprise Server for .NET Administration Microsoft Management Console snap-in now uses the
Enterprise Server External Security Facility for administration security. By default, it uses role-based
access control based on Windows groups and access rules set in machine.config, as in earlier releases,
but it can now also be configured to use LDAP-based security.

3114758 (1110280)
• A problem that caused an unhandled exception when starting Enterprise Server for .NET

Administration, and that resulted a UI exit, has been fixed.

3210115 (1118588)

Enterprise Server Security

Back to the list

• The mfsecretsadmin utility now supports specific secrets configuration files.
• Invalid keys in mfsecrets no longer result in a crash.
• mfsecretsadmin no longer incorrectly displays an error message when writing to a directory that does

not exist.
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• The secrets.cfg file has been moved to the default vault location.

• Enterprise Server mainframe-style passtickets, used by the ELF and DCAS features, are now supported
when LDAP bind-mode verification is used.

3223436 (1119810)
• In Enterprise Server, the External Security Facility's OS ESM module now supports the Enterprise

Server Digital Certificate Authentication Service (DCAS).

3222786 (1119760)
• An Enterprise Server region running in a PAC and using MFDBFH for the region database with the

database "reslocking" feature supported, and with the External Security Feature enabled, would
periodically log messages similar to "ESFEV0331E Unable to unlock shared memory".

3218610 (1119357)
• An additional configuration option related to retrying on failure, retry bind, has been added to the

MLDAP ESM Module. See MLDAP ESM Module Custom Configuration Information topic in your product
Help for more information.

3215526 (1119267)
• The Enterprise Server External Security Facility's rule-substitution feature now supports the token $

{user_long}, which is replaced with the user's "long name".

3210400 (1118613)
• In the Enterprise Server External Security Facility's administration, in rare circumstances, a one-byte

buffer overflow could occur when processing a list-user request, potentially resulting in heap corruption.

3209383 (1118627)
• In an Enterprise Server security configuration with two or more security managers using the MLDAP

ESM Module, all-groups mode enabled, and group federation enabled, certain ESF Update requests
including the "Update All" button in the Enterprise Server Administration web interface could result in
users losing group membership information. This has now been fixed.

3208297 (1118513)
• Enterprise Server's MLDAP ESM Module has a new option, "maximum qualifiers for initial check", which

enhances the existing "check TLQ first" option. See “MLDAP ESM Module Custom Configuration
Information” in your product Help for more information.

3201021 (1117790)
• The Enterprise Server MLDAP ESM Module's tracing of the effective rule and result for Auth/XAuth

requests now includes the resource class as well as name.

3200710 (1117799)
• In Enterprise Server security configurations using multiple Security Managers with the MLDAP ESM

Module, where all-groups mode is enabled and federation is disabled, user group membership is now
maintained correctly.

3194825 (1117275)
• The MLDAP ESM Module no longer generates "invalid search filter" errors when using OpenLDAP to

search for users with special characters in their LDAP Distinguished Names.

3194796 (1117268)
• An issue with modifying Enterprise Server user groups with names beginning with the hash character

("#") has been corrected.
• An issue with some identifiers that contain the equals sign character ("=") when using LDAP-based

security in Enterprise Server has been resolved.
• es_default_ldap_openldap.ldf no longer deletes entries from the specified LDAP server. Instead, if you

are performing an upgrade you can use the new es_default_delete_ldap_openldap.ldf to delete these
old entries.
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File Handling

Back to the list

• An OPEN OUTPUT operation on an ESDS file, with directive NOFCD3 set, now correctly returns a 00
status.

3224463 (1119982)
• A file status of 9/41 was sometimes incorrectly reported when a file was accessed by many users,

under intensive file I-O. This has now been fixed.

3214504 (1119352)
• Any 9/41 additional status errors will not be logged to XFHLOG if /dev/null or NUL is used.

3214504 (1119652)
• The File Handler running under Enterprise Server no longer returns a file status 500 when trying to

retrieve the next DD.

3211622 (1119086)
• Specifying OUTDD"SYSOUT 121 R" when MF_CBLQDA=ON is set could cause a file locked status for

SYSOUT to occur.

3201420 (1117813)
• Fileshare no longer crashes when run in background mode and signal is processed.

• Rebuild now correctly reports the permitted number of duplicates for idxformat 12.

3201916 (1117985)

• The COUNT=(to) process no longer results in a 114 error.

3225165 (1119987)
• A SORT on a fixed sequential file sometimes did not return an error when the last record in the file was

only a partial record.

3224574 (1119918)
• OMIT=(ALL) parameter now works as expected and omits all records.

3221340 (1119623)
• C'XX' now works with sort-ebcdic.

3220079 (1119548)
• The INREC statement is now working correctly on VB input files with the option FIELDS=(p). This option

specifies using record data from p offset to the end of the record.

3219329 (1119458)
• Validation errors are no longer thrown in mfsort when using conversion FS, TO=PD or TO=ZD.

3217843 (1119512)
• Conversion LS,TO=PD or TO=ZD will no longer generate validation errors.

3217843 (1119644)
• MFSORT merge no longer corrupts the record when being used with INCLUDE/OMIT or INREC.

3217580 (1119277)
• The BLKCCH1 and BLKCCH2 keywords of OUTFIL are now supported. The page eject indicator

character '1' will be replaced by a blank space according to the option which is specified.

3216086 (1119205)
• When sorting an LSEQ file in a region running in EBCDIC, if the record format of the output file was not

specified, it would correctly create an LSEQ output file, but the contents were incorrectly converted to
EBCDIC - this has now been corrected.

3212662 (1118873)
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• The INCLUDE and OMIT statements now work as expected against records inserted by an E15 routine.

3210188 (1118589)
• SORT TRAILER that contains COUNT=(TO) no longer causes JCL to abend with an RTS 114.

3204104 (1118058)
• The emulation of ICETOOL SPLICE KEEPNODUPS no longer gives duplicate output records.

3201555 (1117836)

• Enterprise Server XA reconnections failed to register with MFDBFH following the loss of the original
connections - for example, through the use of the Db2 FORCE APPLICATIONS ALL.

3226856 (1120160)
• Error messages are now reported to the Enterprise Server console, and the region start-up fails, if an

attempt is made to warm start a region using a region database that had not previously been cold
started.

3226448 (1120167)
• A trace event is now output each time an I/O operation occurs that requires an XA connection and no

XA connection for the underlying datastore has been registered. This is designed to help with
diagnosing any file access problems.

3222022 (1119691)
• Specifying "localhost" as the hostname to recover when using "dbfhadmin -openfiles -recover -

host:localhost" or "dbfhadmin -casprocess -recover -host:localhost" failed to resolve to the current
machine name, resulting in the command failing.

3221354 (1119628)
• dbfhdeploy was not reporting the underlying ODBC error that resulted from a database connection

failure.

3221103 (1119661)
• If a single Db2 database hosted a datastore and a region with the same name, database operations

would fail for the region if the datastore had been accessed first (and vice versa) due to the same
database connection and schema being used for both the region and the datastore.

3219905 (1119487)
• The Micro Focus Database File Handler (MFDBFH) documentation now includes a reference topic

listing the database permissions required to create new databases, and to handle data files stored in a
database. Administrators can use this information when setting up roles within their database instances.

3217410 (1119273)
• DB2 support has been added to MFDBFH.

3203127 (1117981)
• dbfhdeploy can now be used to download files that are opened for read-only access by other processes.

Previously, you could only download only files that were not open by other processes.

3202402 (1117910)
• When using a Db2 MFDBFH datastore, an exception occurred when attempting to lock an already

locked record.
• dbfhadmin did not output an error message to indicate that the specified datastore URL (specified by

the -datastore: command-line option) did not have a corresponding configuration entry in the
MFDBFH.config file.

• When using PostgreSQL, when a KSDS file was deleted, the associated rewrite stored procedure was
not being removed.

• CAS processes using database resource locking no longer crash with a primary key constraint error
when attempting to create global locks.

• dbfhdeploy was incorrectly reporting a 3/0 file status (I/O error) when downloading a file locked by
CICS. A 9/65 error (File Locked) is now reported.
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• An RTS 114 error occurred when copying a database-hosted file to another database-hosted file if
either the source or destination file URLs specified a datastore for which there was not an MFDBFH
configuration file entry.

• "dbfhadmin -openfiles -recover" was incorrectly reporting that no files had been closed when the open
files were in the root folder.

• JCL IDCAMS steps that define alternate keys used to fail for database-hosted files.
• Deleting a large number of files in a single operation sometimes failed due to the database's transaction

log becoming full when using a DB2 MFDBFH datastore.
• An error message RTS 114 could occur during CASCD termination when the ES_DB_SERVER

environment variable had been set, but no associated region database was configured.
• The "dbfhdeploy delete" command has been enhanced to allow the deletion of a folder (and all of its

sub-folders and files), and to allow the deletion of multiple files in a folder using a filename filter (such as
replacing characters in a file name using a wildcard, '*', and/or a question mark, '?').

• Reading a record from a transactional file hosted in a PostgreSQL would hang if that record had
previously been written within the same CICS transaction.

• The dbfhadmin command line utility now allows you to list/free region resources that are still locked after
a system failure. Use dbfhadmin -region -list|-recover

• EXEC CICS READQ TD performance was slow when the TD queue was hosted in a DB2 database.
• Active TDQs hosted in MFDBFH datastores were not displayed by ESMAC if they had records locked by

a concurrently running transaction.
• CASSI processes would sometimes hang on termination, following a previous soft kill of a job, when

Db2 datastores were being used.
• A new command line utility - dbfhconfig - enables you to build and maintain a database configuration

file, meaning that you are no longer required to hand-craft the file. You can also use a secrets vault to
store sensitive logon credentials , instead of these being on view in a configuration file. Finally, a CTF
trace can be configured to trace ODBC and vault-related operations.

• This product now includes the dbfhconfig utility. It enables you to create and maintain an MFDBFH
configuration file eliminating the need to manually edit the XML file. Optionally, you can use dbfhconfig
to add any passwords and connection strings associated with DSN entries to the product's secrets
vault.

• Cancelling a job which was waiting for an ENQ did not always remove the ENQ request from the
(cross-)region database.

• MFDBFH no longer fails if the MFDBFH_SCRIPT_DIR and/or MFDBFH_CONFIG environment
variables specify a quoted path name.

• Unpredictable results could occur for applications with files open in two or more datastores due to a
clash of file handles.

• It is now possible to switch on/off I/O file optimization when deploying files via the dbfhdeploy command.
Also, file optimization is now available for ESDS, KSDS, and RRDS files hosted in a database, that are
opened for input - add optio="+oi" to mfdbfh.cfg to enable.

• MFDBFH now automatically reconnects the Db2 datastore and any (cross-)region database
connections when they are lost.

• Intermittent ODBC errors could occur during JES initialization after the termination of an initiator
process running a job in a previous session.

• dbfhdeploy incorrectly reported that a datastore did not exist for SQL Server operations when the
"master" database had not been configured. A similar issue occurred for PostgreSQL datastores when
the "postgres" database had not been configured.

Form Designer

Back to the list

• 64-bit versions of nmcnvrti.obj and nmcnvrto.obj have been added.

3207452 (1118373)
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Header-to-Copy Utility

Back to the list

• h2cpy could produce an RTS 114 error if the number of DEFINES was greater than 167.

3220579 (1119558)

IDE

Back to the list

• The build action is now set correctly for resource files in projects imported in Visual Studio using the Net
Express Import Wizard.

3224012 (1119877)
• The IntelliSense suggestions for completion of IF and EVALUATE statements now include alphanumeric

functions.

3220860 (1119561)
• When debugging a Mainframe Subsystem application, and the "Launch" option in the debug properties

of the project is set to "Any", you receive a warning message when debugging starts. If you do not want
to receive the message, you can disable it from the Visual Studio options - click Tools > Options >
Debugging > Micro Focus COBOL, and check "Do not prompt when using the 'Any' launch option".

3220636 (1119730)
• A new Visual Studio debug configuration option, "Do not stop on program entry", is now available. With

this enabled, the debugger only stops at breakpoints and not on transactions.

3216870 (1119253)
• If a build of a PL/I application failed with an error, subsequent builds could be skipped.

3214047 (1118952)
• The "Application Configuration File" item template for native projects now has a .mfgcf extension

instead of .config. There is no change in the functionality of that file.

3211374 (1118723)
• The Show Catalog and Show Spool context-menu commands in Server Explorer now display the

requested information without requiring a login.

3211044 (1118709)
• The debug tooltips now show the correct value for table items that are qualified.

3210340 (1118624)
• When starting the Data File Tools utility from Visual Studio, it is started with the environment variables

set on the current project.

3208983 (1118682)
• Cleaning a project now deletes all the project's output files.

3208289 (1118702)
• The values of COBOL data items can now be displayed in the Immediate and Command windows when

debugging native code.

3208044 (1118424)
• Automatic insertion of COBOL scope delimiters such as END-IF is now supported for all COBOL

dialects that allow the relevant language syntax.

3207789 (1118388)
• The Assembler linker messages now appear in the Error List and in the Output windows in Visual

Studio.

3204670 (1118124)
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• The build process is no longer interrupted errors occur in the compilation of either the Assembler, IMS,
or BMS code.

3203365 (1118012)
• .INT and .GNT files are now compiled in the intermediate output directory and copied to the project's

output directory.

3203363 (1118678), 3203345 (1118079)
• The output files for a source file removed from the project are deleted when the project is built.

3203284 (1117998)
• The output files for a source file which is removed from a project will be deleted during the next build of

the project.

3203283 (1117997)
• The .IDY files for the Micro Focus INT/GNT project type are now generated in the same directory as the

generated .INT and .GNT files.

3203070 (1117984)
• The Assembler build task now copies .BAL files to the output directory.

3202532 (1117921)
• Compiling an Assembler program or a COBOL source file in a INT/GNT project now correctly copies the

Compiler output to the output directory.

3202111 (1117881)
• The IMS build task now supports using the IDE environment variables when compiling an IMS source

file.

3201102 (1117825)
• A context menu command, Show DBD List, has been added for Visual Studio Mainframe Application

projects to help view a list of all generated databases used by the project.

3201101 (1117936)
• There is no longer an issue with installing Visual COBOL or Enterprise Developer to a machine that has

the Microsoft Build Tools product installed.

3198943 (1117841)
• There are new editor formatting options in Visual Studio that enable child data items to be aligned

relative to their parent data items.

3198752 (1117634)
• When displaying the Enterprise Server Administration page, the spool or the catalog in the browser

inside Visual Studio, a secure URI is now used if the enterprise server instance is secured.

3198521 (1117609)
• When the debugger fails to attach to an Enterprise Server, if any error information is available it will be

displayed in the Enterprise Server output window in Visual Studio.

3197752 (1117608)
• Building an Assembler application now correctly generates a .MOD output when the "Linker output"

property in the project's properties is set to "Non-executable data table".

3196420 (1117375)
• COBOL types and members will now be updated for source files that contain parse errors.

3193694 (1117160)
• The following new context menu commands are available for opening files in the Catalog of an

enterprise server file from Server Explorer: 1) Default Application - uses the editor which is associated
with the file extension in Windows. 2) Visual Studio - uses the editor which is associated with the file
extension in Visual Studio. 3) Data File Tools - only visible if the file type is supported by Data File Tools.
Uses Micro Focus Data File Tools.
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3192312 (1117122)
• It is now possible to open files in the Data File Editor using the Edit command in the Catalog and Spool

windows.

3192312 (1117123)
• The 'Full Path' property is now displayed in the Properties window when a copybook is selected in

Solution Explorer.
• When debugging native COBOL code, stepping over a STOP RUN or a GOBACK statement and

immediately stepping back into the debugger no longer causes an 'Unable to step. Catastrophic failure'
message to be displayed.

• When viewing the contents with replaced values of a copybook referenced in a COPY...REPLACING
statement, a Program Symbols (.IDY) alert bar is no longer shown.

• If both the condition text and hit count are changed for a conditional watchpoint, the watchpoint is now
correctly updated.

• The COBOL Visualizer now displays a word wrap option when you select the text tab.
• The COBOL Visualizer no longer truncates the display of data items containing null bytes when

debugging .NET COBOL code.
• Previously, the context menu in Server Explorer was slow to display when selecting a server

immediately after starting Visual Studio, or when a large number of servers were defined.
• Adding a resources file (*.resx) to a .NET Core COBOL project no longer results in build errors.
• The Settings File editor now correctly opens settings files in .NET Core COBOL projects.
• The SQL Property page for .NET Core projects has been removed because .NET Core projects cannot

include SQL database access.
• You can now navigate to the source code of a program shown in the Program Flow and Data Flow views

when the COBOL editor option 'Enable Expanded Copybook View' is set to false.
• It is now possible to navigate to the source code of a program shown in the Program Flow and Data

Flow views when the COBOL editor option 'Enable Expanded Copybook View' is set to false.
• COBOL projects could not be built when using Visual Studio 2019 16.3.
• There is no longer an issue with creating new SQL CLR projects in Visual Studio 2019.
• IntelliSense could stop working when copybooks referenced in the editor using COPY... REPLACE

statements were expanded.
• New copybooks created using the "Extract to Copybook" command will not be added to the project in

Solution Explorer. They are now referenced in the project with the Copybook Paths property in the
Properties window.

Interface Mapping Toolkit

Back to the list

• A problem that caused an erroneous JSON response to be generated when an empty array was
present has been fixed.

3217017 (1119563)
• You could receive an intermittent failure if you code has interfaces that contain multiple parameters that

each map to linkage items containing COBOL tables defined with the OCCURS DEPENDING ON
clause. This could occur due to referencing of freed memory.

3179075 (1116037)

• Enterprise Server now supports JSBIND files greater than 1MB in size.

3208935 (1118688)
• When using Web Services, a COBOL service with a parameter containing nested OCCURS

DEPENDING ON tables no longer crashes if one of the nested tables is of a primitive data type.

3204381 (1118234)

• When sending a request to a CICS Web Service, data for all "FILLER" group items within the same
COBOL group are now correctly returned.
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3221568 (1119656)
• A problem that caused a CASPI1009E error-OUTPUT_OVERFLOW to occur when a SOAP message

was sent for channel-based SOAP services having string data greater than 64K has been corrected.

3209490 (1118583)

IBM Language Environment for OS/390 & VM Support

Back to the list

• An error in calculating the start of the LE century window has been fixed.

IMS Support

Back to the list

• When importing an IMS Data View, a PCB statement in the specified PSBSRC file was being incorrectly
analyzed, causing the Data View Import to fail. A fix has been put into place to correct this issue.

• The error code of a field search argument (FSA) is now returned to a FLD call.

3220405 (1119523)
• When using the AIBTDLI interface, a GET call followed by a CHKP returned a U100 ABEND. This has

been fixed.

3212284 (1118798)
• A partially successful GN call with multiple SSAs and some with Boolean logic could return an incorrect

segment level in the PCB key feedback area. This was introduced with the fix for SI 3138482 (RPI
1112600). The proper database position after the unsuccessful call was not affected.

3203792 (1118045)
• IMSTRACE is now produced when the enterprise server instance is configured as EBCDIC.

3202491 (1117917)
• User DB Exits are now supported for GSAM databases.

3200366 (1117812)
• IMS marks a JES container as dirty if an IMS application abends or is aborted. To disable this behavior,

set the following environment variable: ES_IMS_JES_DIRTY_ABEND=N.

3193636 (1117252)
• An OPEN of a secondary index DB did not automatically retry if the file was held exclusively by another

job, resulting in a 9/065 open error. This has been fixed.

3192082 (1117021)
• A problem that restricted the /START DB command when a PROCOPT=GO PSB was active has been

corrected.

3160070 (1117397)
• An RTS114 error sometimes occurred when an IMS DB with no defined segments larger than 250 bytes

was used, and the localdli feature was enabled. This was due to a buffer overrun, and has now been
corrected.

3155265 (1114287)
• Update-intent locks were incorrectly issued in IRLM for PROCOPT=G PCBs. This created unnecessary

lock constraint.

• The size of the output control buffers generated by MFS has been increased to be compliant with the
maximum size of 32K.

3225323 (1119988)
• The buffer size to handle controls and literals for large MFS source files has been increased.

3222665 (1119742)
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• The MFS generator now handles FILL=NULL correctly for EBCDIC and EGCS control blocks. MFS
code of the form shown below now sets the null compression bit in MID and MOD headers correctly in
MFS files compiled with CBEBCDIC and CBEGCS options: MSG
TYPE=INPUT,SOR=(DV0670),NXT=MODV0670 LPAGE SOR = (DPAGE1) SEG MFLD
PFKFLD,LTH=22,FILL=NULL MFLD 'TRNV0670 ',LTH=9

2822469 (1099666)

• In a situation where the AIBTDLI API call for a database retrieval also requests an IO area length which
is less than the actual length returned, you no longer receive an U100 abend. Instead, control is given
back to the application and you can check the AIB return and reason codes.

3223544 (1119857)
• BMP applications can now use the SSM specification in the DFSRRC00 PARM= to select the preferred

resource manager when multiple XA resource managers are defined.

3222338 (1119740)
• An incorrect destination was used when a BMP issued multiple messages from a modifiable alternate

PCB. This issues was introduced with the fix for RPI 1117611.

3221948 (1119657)
• When an IMS86ENT system exit is installed, the initialization (INIT) function was issued before the

application environment was established. This caused problems for Assembler debugging and with
AMODE pointer formats in MVS control blocks. This has been corrected by delaying the INIT function
until the application environment is established. As a result of this change, support for version 1 of the
IMS86ENT interface has been dropped, and support for specifying the old PCB list format has been
dropped for version 2. This is a concern only for IMS86ENT modules that are more than 20 years old as
of this release.

3204941 (1118157)
• Swedish characters in MFSGEN, PSBGEN and DBDGEN error messages were displayed incorrectly.

This has been fixed.

3204665 (1118780)
• The following IMS commands are now supported: /START TRAN ALL, /DISPLAY Q TRAN, and /

DISPLAY STATUS TRAN.

3201229 (1117798)
• Inbound queue BMPs are now fully supported.

3198857 (1117611)
• SSTM JCL for IMS and CICS did not support the WIDTH() and NOHEX parameters. This has been

fixed as follows: WIDTH=<n> - Sets the width of the line in the trace file to the value of <n>, where <n>
is an integer from a minimm of 50 to a maximum of 110. NOHEX - Supresses the display of hex values
in the trace. Example: //BTSCONFG DD * PCB SSA IOAREA STATS TIMES LISTFILE WIDTH=80
NOHEX /*

3192316 (1117081)
• Please add this RPI number and supportline number to the readme entry for RPI with 1118157.

3188517 (1116731)
• Two new options of BTSCONFG, CONSOLE and JESLOG, enable you to direct the BTS trace output to

the Enterprise Server console and to the job log, respectively.

• For IMS Connect requests for conversational transactions, the transaction code is no longer prepended
to the message.

3220261 (1119536)
• A PURG call from a PL/I application without an IO area (parm count 2), could cause a memory fault.

3220120 (1119495)
• The default behavior of IMS Connect is to set LTERM (if not explicitly overridden) to the port-ID when

commit-mode is one. It is now possible to override this behavior by setting the environment variable
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ES_IMS_CLIENTID_LTERM=Y to the server’s configuration information. In this case LTERM would be
set to the client-ID instead of the port-ID.

3216740 (1119263)
• ES IMS TM WFI (Wait For Input) MPPs (Message Processing Programs) now honor the configured

processing limit specification. They now also receive a QC when commanded to stop or when
Enterprise Server enters shutdown phase one processing. ES IMS TM HSF (Historical Statistics
Facility) now correctly report the processing time, schedule latency, user ID and LU (Logical Unit) for
transactions that are processed by an MPP after the initial transaction. ES IMS TM now allows an
MPP’s post QC logic to execute during phase one of Enterprise Server shutdown.

3215544 (1119080)
• A problem that caused the LTERM name of the initial connection to be changed upon user sign-on

when the enterprise server region configuration specified the ES_IMS_LU_LTERM=Y environment
variable has been fixed.

3210531 (1118642)
• Issuing a /DISP USER command for a stopped user no longer results in an RTS 114 error.

3210356 (1118662)
• For IMS Connect requests, the default LTERM name is now correctly set to the Client ID when the IRM

commit-mode is zero. When the commit-mode is one, the default LTERM name continues to be set to
the port number.

3206345 (1118494)
• Issuing an IMS command with missing parameters at a 3270 terminal no longer results in an RTS200

error.

3199381 (1117788)
• A problem that sometimes caused an RTS200 error has been fixed.

3188009 (1117134)

• The mfims utility was looping where parsing a stage 1 extract file, when the file had a parameter in the
form of "keyword=," . This has been fixed.

3224785 (1119939)
• In order to successfully use the Drag And Drop utility to load local IMS databases, you must set the

environment variable ES_ACBLIB to the location of the generated ACBs. If this variable is not set, then
the variable ES_IMSLIB will be checked for ACBs. Other locations defined by environment variables
such as ES_IMSLIB2, ES_IMSLIB3, etc. will not be checked. Additionally, if an invalid directory (such as
one that does not exist), the search terminates. Any directories assigned to the IMS variables must be
valid.

3217859 (1119302)
• A problem that prevented the UNLOAD and LOAD functions of the IMS database utility (IMSDBU) from

removing orphan segments in the database or unload file has been resolved.

3216293 (1119535)
• The IMS stage-1 extract utility no longer hangs when sublists span multiple lines.

3197178 (1118104)
• The following corrections have been made to the Stage-1 extract: - APPLCTN macros that start with

RESIDENT or DOPT are now accepted - APPLCTN macro, PGMTYPE= parameters defined with
unnecessary parentheses are now accepted. For example: PGMTYPE=(TP) PGMTYPE=(BATCH) -
APPLCTN macro, PGMTYPE= parameter class code definition is now used when subsequent
TRANSACT macros do not define a class code in the MSGTYPE parameter - The limit on TRANSACT
macros per APPLCTN macro have been removed

3168373 (1115085)
• An arithmetic error sometimes occurred when using IMSDBU to operate on an empty IMS

database.This has been fixed.
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2812019 (1098275)

JCL Support

Back to the list

• When creating a new PDSM file with multiple possible extensions, the JCL engine may have selected
the last extension in the list and not the first. This has been fixed.

3222743 (1119745)
• An issue with REPRO processing that prevented concatenated input to be written to the output when

the first dataset was empty has been resolved.

3222490 (1119723)
• Certain performance improvements have been made for REPRO operations when using database-

hosted data sets.

3221949 (1119824)
• The splregr utility no longer reports a duplicate record error when writing to the casspool file.

3220666 (1119547)
• An issue with opening the spool control files when they are database hosted has been resolved.

3220461 (1119528)
• A used symbol is no longer incorrectly identified as unused, when the same symbol name is used and

the value is changed in subsequent steps.

3219129 (1119411)
• Existing records in a target file of a IDCAMS REPRO command are now removed correctly even when

the source file has no records to be copied.

3219021 (1119401)
• An error that resulted in the incorrect JCL symbol being used in a job with a SET symbol name and an

EXEC procedure with a parameter of the same symbol name has been corrected. The overriding EXEC
PROC parameter is now used correctly.

3218403 (1119384)
• A compiler error in the sample spool API programs, SPOOLCOB.cbl and SPOOLPLI.pli, caused by an

incorrect field name, has been corrected.

3215587 (1119090)
• An error in the Catalog Maintenance Utility (MFCATMNT), which prevented multiple data sets from

being removed, has been corrected.

3215585 (1119135)
• The size of the deliminator for in-stream data (such as DLM=AAAA) has been increased to eight

characters for JES2 JCL jobs. The size is limited to two characters for JES3 JCL jobs.

3214287 (1119085)
• An issue has been resolved that was stopping FTP 'put' processing for a PO file that followed an FTP

'put' process for a GDG generation.

3214157 (1118956)
• An error when using LISTDS with data set names that consist of more than 6 nodes has been

corrected. (The maximum number of nodes in a data set name is 22.)

3210286 (1118599)
• The %PCDSN extension can be used to set the location of a GDG when you define it with IDCAMS.

3210206 (1118679)
• It is now possible to use static system symbols defined in SYS1.PARMLIB(IEASYM00) in JCL jobs.

3207122 (1119387)
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• The file status on return from a catalog delete action was occasionally incorrect, giving a value of 23 -
not found.

3206007 (1118318)
• The JCL engine has been updated so that JCL OUTPUT statements support the following: AFPSTATS,

AFPPARMS, MAILBCC, MAILCC, MAILFROM, MAILTO, REPLYTO, USERPATH.

3205480 (1118229)
• The processing of symbol values within nested procedures now returns the correct value for the nested

level.

3205074 (1118149)
• The spool CREATE-DATE and CREATE-TIME passed to the printer exit now contain the correct values.

3205024 (1118170)
• You can now adjust the value of MF_UCC11 used for a job by using the MFJUXIT user exit.

3203148 (1118043)
• You no longer receive an error message when running the Batch TSO command processor from a PL/I

program.

3201691 (1117858)
• A problem that resulted in an INTRDR data set not being submitted to the Internal Reader following the

submission of an empty data set has been corrected. The submission of an empty INTRDR data set will
now cause a new physical file to be allocated to the DD for the next use. The empty data set will be left
on disk.

3198143 (1117676)
• An issue in MFJPTPCH which caused sysout datasets to remain 'ACTIVE' after the step had completed

has been fixed.

3196948 (1117448)
• A change to the dataset disposition processing introduced in ED 4.0 PU9 that stopped catalog entries

being updated has been corrected.

3194787 (1117229)
• Am issue that caused the ELSE and ENDIF lines of a job-stream to be missing from the job log has

been resolved.

3193418 (1117114)
• A SYSPRINT message has been added, which indicates that a GDG file has been altered by IDCAMS.

3187283 (1116862)
• The user exit mfjfaxit.cbl can now be used to receive notification of JCL 'file open' events.

3181759 (1116185)
• The user id and password now support spaces as well as forward slash symbols ('/') as separators.

3179919 (1116060)
• A memory error could occur in mvscatio when checking for a possible separate idx file.

(642712)
• MVSSPLHK incorrectly reported a JCLUT0110U error with seven digit regions and no INDEXO

definition in the job step.

• The number of executable statements which exceed the 255 limit is now reported correctly.

3216719 (1119261)
• A failure when renaming the separate data set index file when performing an IDCAMS ALTER

command has been corrected.

3213354 (1119063)
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• The validation of the USER or UINF field in a VSE POWER LST statement has been corrected.

3198561 (1117575)
• It is now possible to assign 'SYSIN' as a Logical Unit id in the VSE configuration file. It must have a

corresponding device id, and the device type must be 'READER'. 'SYSIN' can be used when assigning
an in-stream input dataset.

3196337 (1117434)
• Parsing errors for JSEP option and DEST user id on PWR LST statements have been corrected and the

parameters are now passed to the printer exit. The limitation on the BUFSP value has been increased
in line with the mainframe value.

3195118 (1117292)

Licensing

Back to the list

• Windows Server 2016 machines might need to be restarted regularly because of a large number of
open handles on the mfcesd (Micro Focus Compliance Enforcement daemon) process. The open
handles are now freed correctly and will no longer accumulate.

3213000 (1118881)
• An application being deployed using the CESDYNAMIC option of a Runtime Launch Configuration file

now succeeds in getting a licence when executed for a second time.

3160922 (1114454)

Micro Focus Common Client

Back to the list

• Memory-access errors no longer occur in MFCC (mclient.dll/ cobmclient.so/libmclient.so) when certain
malformed messages are received from the server. MFCC now detects these conditions and logs an
error message.

3213653 (1119419)
• cassub and other Enterprise Server utilities now support host names of up to 255 characters long.

3196153 (1119249)
• The IMTK service-deployment function can now read credentials for secured deployment services from

the MFCC configuration file mf-client.dat.

Micro Focus Directory Server

Back to the list

• MFDS CA server root certificate and TLS client options are now available via the ESCWA UI.

3218442 (1119593)
• The Shared Memory Cushion entry field in the Enterprise Server Administration UI now accepts five

digits.

3210200 (1118594)
• If external security is configured for the Micro Focus Directory Server (MFDS), then a user attempting to

import region configuration using the "mfds -g" command now requires "Add" and "Delete" permissions
for the "Repository Access" resource under the "Enterprise Server Administration" resource class.

3209555 (1118581)
• The mfds -g command line waits to time out rather than receiving an immediate fail as a result of an

import error.

3209555 (1118572)
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• In some circumstances, the Micro Focus Directory security settings were not being saved. This has
been fixed.

3209389 (1118705)
• If the MFDS process is not TLS-enabled, setting the MF_ROOT_CERT environment variable could

cause region startup to fail. This has now been fixed.

3205462 (1118274)
• The Micro Focus Directory Server KEEPALIVE and some other connections to a TLS-enabled

Communications Process Control Channel listener were failing to connect. This was because they were
using the IP address rather than the hostname which the certificate requires.

3204824 (1118193)
• If the MFDS -o option is used to override the options file location, option changes were not successfully

saved. Use the same location when saving option changes, and this problem does not occur.

3171825 (1115391)
• ESDEMO64 is now in the standard MF Directory Server startup repository together with ESDEMO. If

the MSSIVP repository is imported it contains MSSDEM64 together with MSSDEMO.

3168860 (1115116)
• If the environment variable MFDS_DNS_RESOLVE=Y is set, then the Enterprise Server Administration

web interface's HTTP response headers will not return the MF Directory Server IP address in HTTP
cookie values.

2863212 (1104835)
• Previously, changes made to the listener configuration in the Enterprise Server Administration Web UI

were not becoming active for a started region.
• The MF Directory Server process could abnormally terminate if the listener description text input via the

Enterprise Server Administration Web GUI was greater than 64 characters in length.
• A number of XSS vulnerabilities in the Enterprise Server Administration have been resolved.
• Under some circumstances, it was possible to set MFDS restricted access with improper credentials

checks.
• Any region auto-start credentials and XRM open string values are now stored in the MF secrets vault

facility if the Micro Focus Directory Server is configured to use it.
• When the Micro Focus Directory Server is running in a container, the region status is set to started only

when all expected listeners are started.
• The mfds -l schema export command-line option now supports the OpenLDAP OLC (on-line

processing) LDIF file format (use option 4).
• When adding a listener using the Enterprise Server Administration Web UI, the initial listener state was

incorrectly set to "Invalid".
• In the Enterprise Server Administration Web UI, the service namespace values of the deployed REST

services were incorrectly displayed.
• MFDAS XML import can now import more than one comms process.
• The ESCWA API would reject adding a listener to a region if there was already a listener with the same

requested fixed port value defined in the target MFDS.

MF Server Administrator (GUI)

Back to the list

• There is no longer an issue with using the mfds -g option to import an XML region definition with
services that reference listeners.

3219549 (1119459)

Mainframe Access

Back to the list
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• MFA Client now rounds any mainframe time difference to the nearest time zone block where a block
consists of 30 minutes.

3223202 (1119813)
• MFDAS secchk is now handling negative time differences correctly.

3223202 (1120059)
• MFAWrapper findmem can now scan for up to 803 members.

3219388 (1119426)
• MFDAS Findmem now supports copybooks with embedded binaries.

3218396 (1119388)
• MFDAS no longer restricts /CATOVERRIDE to a subfolder of the catalog location.

3213304 (1118931)
• Missing CGMQ application servers on MFA Sever configuration migration are now handled correctly.

3199393 (1117660)
• Zero length files no longer result in a hang on MFDAS VSAM import.

3194976 (1117273)
• Dataset names are now folded to upper case on catalog import.
• When using the USS Explorer view to list files and directories of a path that contains a symbolic link to a

non-existent file, truncation of returned data would occur.

• TAUTOXCC REXX has been updated to enable it to allocate and deallocate the required SYSMDECK
and any additional SYSUTnn datasets. It also marks the point where the COBOL 6.3 library
(IGY.V6R3M0.SIGYCOMP on CSIMVS) is selected over the current 4.1 library
(IGY.V4R2M0.SIGYCOMP).

3220259 (1119637)
• New parameters TSO_NOTIFY and TSO_MSGCLASS have been added so that TSO session tasks

have NOTIFY and MSGCLASS specified on their job cards.

3218215 (1119435)
• The parameter TSO_JOBCHAR_PREFIX has been provided to specify that the job char should be

prefixed to the job name.

3214413 (1118992)
• Messages MFM0014I/12I/13I are now emitted again if XML parameter files are being used. Previously,

these were emitted by the old-style parsing routines.

3210348 (1118602)
• MFA creates dependent ASIDs using the reusable ASID attribute because they use cross-memory

services. If this does not happen, ASIDs might become depleted which results in the following message:
"IEA061E REPLACEMENT ASID SHORTAGE HAS BEEN DETECTED" However, due to deficiencies in
DB2, if it is invoked from a reusable ASID, it abends with 0D3. A new MFA configuration parameter,
REUSE_ASID="0", has been provided so that you can start MFA-dependent ASIDs as non-reusable. If
message IEA061E is received, all MFA ASIDs will be shut down to mitigate the shortage.

3208212 (1118422)
• MFAAS tasks will now be shut down if inactive for a certain period in all circumstances.

3206480 (1118407)
• A new configuration parameter, COMPRESSION_TYPE, with values "0" or "1" has been added to MFA.

When COMPRESSION_TYPE="1", the client can negotiate to turn off data compression, which could
dramatically improve performance when transferring binary files.

3205825 (1118218)
• An attempt to catalog a data set with an invalid recfm/blksize/lrecl combination results in an error

message being displayed.
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3205761 (1118228)
• The CEE libraries have been removed from MFAAS STEPLIB. This is because they are not needed and

could cause issues if they are not in the APF list.

3205421 (1118189)
• The version of HLQ.MFA.EXEC(TAUZCAPP) shipped with the product contained an incorrect default

location for the SYSDSN variable.

3202754 (1118103)
• The version of HLQ.MFA.CNTL(MFATSO) shipped with the product contained incorrect default values.

3202754 (1118088)
• MFA will no longer cause data sets on tapes to get an allocation failure 0218/0000 when the tape needs

to be mounted.

3197647 (1117758)
• You can now use MFDAS to download keyword Endevor members.

3185781 (1116540)
• A new parameter CONSOLE_NAME has been provided so the actual console used to execute JES

commands on behalf of a user may be specified. By default, the master console is used.

3185156 (1117142)
• MFDAS Rename of datasets now returns the correct return code.

• VSAM PRO files no longer receive incorrect minimum LRECL values from MFA downloads.

3209412 (1118578)
• In Visual Studio, there is no longer an issue with saving edited files to the mainframe from within

Mainframe Explorer.

• Catalog processing has been updated to deal with unexpected output from IGGCSI00. You must be
using at least MFA V7.0 to take advantage of this update.

3190132 (1116977)

Micro Focus Batch Scheduler Integration

Back to the list

• Support has been added for secured Redis when using MFBSI in a PAC.

3225748 (1120060)
• Control-M variables starting with a # character were not handled correctly.

3222729 (1119761)
• Under some circumstances, mfbsijcl would not stop executing and would not return RC208 to the

scheduler.

3219288 (1119462)
• On 64-bit AIX machines, internal MFBSI time stamps were incorrect.

3205581 (1119053)
• The sample in the topic "JCL Parameter Substitution" has been clarified to show the need for an extra

period in the MFBSI basic substitution.

3203025 (1117969)
• Support has been added for the Control-M function %%$WCALC which requires one or more Control-M

Calendar definitions. See your product Help for details about how to create Control-M Calendars.

3191119 (1116965)
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Micro Focus Unit Testing Framework

Back to the list

• We recommend that you rebuild your unit test shared objects, or dynamic link libraries, or any file that
includes mfunit.cpy, as a change in the contents of this copybook might result in a run-time error.

3222692 (1119866)
• Micro Focus Unit tests with data driven tests that use CSV have had some size limit increases.

3214717 (1119038)

PL/I Support

Back to the list

• Register allocation algorithm has been improved to fix some cases where SELECT_REG was unable to
select a register.

3219161 (1119418)
• Using -prefix options will no longer cause parameter corruption on calls to array entry variables.

3207573 (1118576)

• MFPLI now embeds compiler version information string in the .data section of each object file or library.
It starts with a special character i.e. @(#) so that it could be searched easily.

3220567 (1119545)
• The Open PL/I diagnostic message MFPLI01227W pertaining to passing arguments BYVALUE has

been relocated from the call point to the declaration of the entry, and modified appropriately.

3220424 (1119648)
• A problem with the LEFT, RIGHT, CENTERLEFT, and CENTERIGHT built-ins accepting a fixed binary

data item as the first argument has been fixed.

3216779 (1119208)
• An optimization has been put into the symbol handling routines to increase the speed of the compiler.

3215758 (1119110)
• A problem with an EXEC SQL statement split across %INCLUDE files has been corrected.

3214324 (1118985)
• The NOINIT attribute will not be inherited anymore if a variable is declared LIKE another structure

variable.

3207149 (1118360)
• A compiler problem related to using the options -zalign -nolaxbased has been resolved.

3206200 (1118259)
• You now receive a warning message when executing a PL/I program that has a SELECT statement

which does not contain any WHEN or OTHERWISE clauses.

3196179 (1117356)
• Executing PL/I code no longer generates an error condition if a SELECT statement is empty.

3196179 (1117357)
• Setting up an ON unit which utilizes an uninitialized FILE VARIABLE could result in a trap at execution

time when the ON unit was established.

3196179 (1117364)
• The Open PL/I compiler now diagnoses an unqualified name resolved to a structure member rather

than a matching non-member declaration of the same name in a parent block with an Informational (I-
level) diagnostic (MFPLI01305I).

3190928 (1116926)
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• A compiler issue with the -rc 4,0 option has been fixed.

3184621 (1116421)
• The -bifprec {15|31} option that sets the precision of a built-in function’s result to 15 or 31 is now

supported.

3182406 (1116280)
• A problem with diagnostic message file and line numbering when a declare statement is split across

%include files has been fixed.

3179779 (1116068)
• XREF tables in the compiler listings now include extra details such as entry parameter descriptors,

options and return type.

3179057 (1116109)
• The problem related to default range statement in a particular scenario involving based storage class

has been fixed.

3178279 (1115951)
• The behavior of default range has been modified to support the following syntax: DEFAULT

RANGE(IDENTIFIER:IDENTIFIER)

3178219 (1115941)
• A problem related to array cross-sections when specified in STRING BIF or pseudo-variable, has been

fixed.

3178027 (1115916)
• The behavior of assignment to limited entry has been fixed.

3176698 (1115817)
• A problem when using LIKE attribute on a structure with any member having repetitive initializers via (*)

has been fixed.

3174555 (1115628)
• Using string pseudo-variable sometimes incorrectly ends up in severe error MFPLI00164S (Invalid

conversion required by an assignment or RETURN statement). This has now been fixed.

3163727 (1114733)
• The TRIM built-in is now supported when applied to structures.

3163164 (1114710)
• The LEFT built-in is now supported on arrays. In addition, the RIGHT, CENTERLEFTT, and

CENTERRIGHT built-ins are also supported on arrays. Restriction: Arrays of structure or structures
containing arrays are not yet supported.

3163163 (1114709)
• All information is covered in RPI 1113159 (combined).

3140468 (1113161)
• Open PL/I now supports the FIXEDBIN and FIXEDDEC built-ins. In addition, the FLOATBIN and

FLOATDEC built-ins are also supported. Restriction - array arguments are not yet supported.

3140466 (1113159)
• The VALID built-in function now supports fixed decimal arguments.

3139150 (1112862)
• The COPY option in GET statements is now supported.

3139143 (1112841)
• The Open PL/I compiler now supports the GENERIC attribute.

3139122 (1112605)
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• The Open PL/I Compiler and run-time now provide support for the built-in functions FILEREAD,
FILEWRITE, FILETELL and FILESEEK when used with files of RECFM=U or ENV(U).

3137457 (1112594)
• A problem causing the SQL preprocessor to abort has been fixed.

3118614 (1110627)
• The ENV attributes RECSIZE, KEYLOC and KEYLEN can now have argument of type static fixed

bin(31).

2857789 (1104097)
• A problem related to the use of -debug option and extremely large decimal values in %REPLACE

statements has been fixed.

• During evaluation, the depth of a structure's child was miscalculated when the pointer it was being
dereferenced from was also part of a structure (i.e. a.b -> c.d, the depth of d was miscalculated). This
has now been fixed.

3215015 (1119032)
• Variables with a # and/or @ in the name can now be evaluated in the CodeWatch debugger for PL/I.

3214780 (1119013)
• The way parameters were passed through cw_java to the program to be debugged was compressing

spaces in string arguments that were enclosed in quotes. That has now been fixed.

3209251 (1118587)
• Enhancements have been made to the debugger to support figuring out the next debuggable statement

which will be executed when the user steps off the end of a PL/I On Unit. This allows the debugger to
set a temporary breakpoint so the user can continue stepping through the user program upon return
rather than execution "running" to the next user breakpoint. Stepping through a PL/I GOTO statement
from an On Unit is supported as well.

2674783 (1095097)
• Support for the old ioctl-based version of the /proc interface is no longer available by Oracle, so it had to

be replaced with the new structured /proc interface.
• If your project was missing some DC files, the debugger would still call the DC API when searching for

an include file id.

(638064)
• Frames were being handled through COBOL, and failing because of a change on the COBOL side. This

has been fixed by now handling frames through PL/I.
• A problem where character varying variables could not be edited in the expressions view when

debugging has now been fixed.
• Related expression objects were being handled through COBOL, and failing because of a change on

the COBOL side. This has been fixed by now handling related expressions through PL/I.
• A problem where the user was stopped outside of user code after hitting suspend has been fixed.
• When trying to debug a program that references or exports main, the debugger no longer hangs.

Instead it shuts down and the actual issue of not being able to debug it still persists.
• The problem where bit variable values could not be changed when debugging has been fixed.

• The XMLDEMO example as shipped failed on the call to the PLISAXA API because the events structure
passed to it was not using the required data type of ENTRY LIMITED. The examples have been
updated to match the XML support.

3191102 (1116960)

• Text strings that spanned more than two lines with margins in effect, after the first line they were not
treated as literals and were split incorrectly. Now, text strings that reach the right margin, are split (right
margin), with the next line starting at the left margin.

3220169 (1119510)
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• Previously, if your macro attempted to build a literal string larger than 16392 bytes, it would cause an
error condition. The macro preprocessor now supports literal strings up to 32767 bytes.

3213596 (1118910)
• Previously, if a macro DO statement contained an expression which used a parameter that had the

same name as an element of the DO statement, it would fail with improperly formatted statement
message. This no longer occurs.

3213286 (1118886)
• Previously, when invoking a macro using ANS() that spanned several lines of source code, the error

messages generated for the following lines were not correct.

3198979 (1117618)
• When margins were in effect, comments were split on margins, resulting in debugging generated

information (-tagdbg) also being split. They are now treated as regular statements.

• Previously, any character greater than 0x7f passed to the PLISAXA parser was not being handled
correctly. It now correctly handles all characters from 0x00-0xff.

3218472 (1119393)
• When executing a PL/I DISPLAY() REPLY(); statement, a failure to fetch MFPLIACPT64 was occurring.

This no longer happens.

3217138 (1119240)
• The performance of the automatic conversion of FIXED DEC values to FIXED BIN values has been

optimized to remove the excess calls to sigprocmask.

3216747 (1119209)
• mfpli performance has been improved to reduce compile time for many programs.

3215758 (1119429)
• Previously, if the CBL_ERROR_PROC API was not already present in the DB2 process which was

executing stored procedures, then a PL/I program would fail at initialization with an ERROR while
attempting to FETCH the entry point. This no longer happens. This was a side effect of the change for
RPI 1115804.

3212453 (1118937)
• A SIGSEGV exception would occur on the OPEN statement of a PL/I file in the second or subsequent

execution of a PL/I jobstep that utilizes DSNRLI.

3194910 (1117529)
• An issue that occurred when an UNDEFINEDFILE condition was raised against a DD that attempted to

read a non-existent PDS Member no longer results in a memory corruption.

3194856 (1117372)
• Previously, if you tried to invoke PLISAXB from a JCL-based program utilizing instream data, and the

temporary instream dataset was in a long and spacey directory, the call to PLISAXB would fail. This no
longer occurs.

3191102 (1118048)
• Heap information is now available in PLIDUMP output.

3150586 (1113742)
• An issue with dynamically turning on CTF traces when a program runs under the control of a JCL-

enabled enterprise server has been resolved.

• The incorrectly produced error message "Severe MPLIE00099S : Internal system error "SYM08-RC
-0000000008 from dsym.". Contact Micro Focus Support." will no longer be produced. This internal
system error has been fixed.

3208678 (1118470)
• The size of a statement the SQL preprocessor (execpp) can handle is now twice as big as before.
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3201949 (1117888)
• Comments immediately adjacent to other language elements (including those reported in the RPI) are

now handled correctly.

3201845 (1117873)
• A problem causing the SQL preprocessor to abort has been fixed.

3188874 (1116775)
• A problem processing multiple EXEC statements occurring at the outermost level of a source program

has been fixed.

3169777 (1115316)

REXX Support

Back to the list

• Closing braces near the end of a line in SYSTSPRT no longer cause a hang.

3216030 (1119170)

Run-Time System

Back to the list

• The NUMVAL intrinsic function no longer produces an error at run time when used with national data in
a program compiled with a mainframe COBOL dialect.

3191506 (1117099)
• The CBL_GET_EXIT_INFO library routine has been further enhanced to detect the circumstances in

which an exit procedure has been invoked. It can now better distinguish between normal and abnormal
terminations.

• In .NET and JVM COBOL code, under numproc(acos), some instances of illegal data in a USAGE
DISPLAY field did not produce an RT163 error when should have.

3215249 (1119051)
• .NET and JVM COBOL only. An issue has been resolved in arithmetic statements where the target item

is a binary item 9 bytes or larger (19 decimal digits or larger) and the result has magnitude which is
greater than or equal to 2**64.

• In .NET COBOL, the default printer routine now successfully searches for and selects a default printer
without causing a system exception "Argument out of range".

3224679 (1119932)

SQL: COBSQL

Back to the list

• COBSQL now supports EBCDIC conversion for FETCH statements with more than ten host variables.

3225338 (1120132)
• Informix now handles cases in which comments were included inside EXEC SQL statements or variable

declarations were broken into two lines inside EXEC SQL statements.

3220792 (1119585)
• OpenESQL now correctly handles calling Stored Procedures with output host variables which use the

dynamic SQL method.

3212664 (1118834)
• A problem that prevented COBSQL from reporting errors to the checker when the precompiler file was

missing has been fixed.

2867407 (1105864)
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SQL: HCO for DB2 LUW

Back to the list

• An issue with ODBC and DB2 ECM generated code not having uniquely named sections has been
resolved.

3224210 (1119896)
• XML data is now correctly sent to the DB2 server.

3220909 (1119685)
• DB2 ECM now handles the CLOB value in EBCDIC correctly when DIALECT(ENTCOBOL) is specified.

3217813 (1119335)
• There is no longer a problem compiling programs with host variable arrays if they are used with the

SELECT INTO statement. A problem with the output host variable array processing where array HVs or
a mix of array and individual HVs were being processed incorrectly has been fixed.

3216314 (1119188)
• The MFHCO tool now takes login credentials from the command line for remote database access

without asking for user inputs through a pop-up window.

3212431 (1118968)
• A ddl command which contains a number of characters greater than 32K could cause a hang condition

in the HCO for DB2 LUW ddl generation tooling.

3205207 (1118168)
• The DB2 ECM was incorrectly handling floating point conversion when runtime option

MAINFRAME_FLOATING_POINT was enabled. This has been fixed.

3198121 (1117644)
• DB2 ECM now supports multi-row FETCH/INSERT/UPDATE, which includes but is not limited to the

usage of the FOR nn ROWS clause.

3155753 (1114251)

SQL: HCO for SQL Server

Back to the list

• An issue where HCOSS would not translate the format for DB2 z/OS TIMESTAMP (or TIME) default
values to SQL Server format has been resolved.

3192321 (1117110)

• A problem loading date values of mixed formats of ISO and EUR using SQLUTB when the Input Date
format was configured to EUR has been fixed. In addition, a problem with the EUR date format
incorrectly processing multiple formats of Date values mixed in the same dataset has been fixed.

3217501 (1119290)
• HCOSS now handles the CHAR() function correctly.

3207701 (1118380)

SQL: Mainframe Batch Database Tools

Back to the list

• When starting the MBDT/ESQL Configuration UI, the registry key entries are now processed correctly.

3227324 (1120217)
• There is no longer an issue with unloading NULL values from DECIMAL fields using SQLUTB if the

enterprise server region is running in ASCII mode. An issue with the data overflow which occurred
during decimal data conversion where NULL values were being processed incorrectly has been
resolved in SQLUTB.
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3223817 (1119860)
• There is no longer an issue with submitting and executing jobs after canceling a SQLUTB job. An issue

with a duplicate connection name which resulted from a SQLUTB job cancellation where the ODBC
connection was being handled incorrectly has been resolved.

3219445 (1119442)
• There is no longer an issue with counting the number of records loaded into the table if the data set

contains duplicated records. An issue with the loaded record counting where multiple counters were
being processed incorrectly has been resolved.

3218617 (1119413)
• There is no longer a problem making XA connection if only the XA ID is given in the SQLUTB utility

parameters. A problem with the SQLUTB utility parameters parsing where the XA ID in the absence of
utility id was being processed incorrectly has been fixed.

3214354 (1118975)
• There is no longer an issue with emulating the Fujitsu mainframe feature of checking LRECL of

SYSREC against the row size if "Check LRECL" is enabled in the MBDT Configuration Tool. An issue
with the SQLUTB LOAD processing where LRECL of SYSREC being greater than the row size was
processed incorrectly has been resolved.

3210919 (1118703)
• SQLUTB now supports multi-tables load.

3207120 (1118344)
• An issue with the SQLUTB loading where duplicated keys or indexes were being processed incorrectly

has been fixed.

3205697 (1118320)
• There is no longer an issue with loading data into a DB2 table if the table has more than 400 columns.

The limit has been extended to 1000 columns. Previously, you would receive an error (SQLCODE:
-99999, SQLSTATE: S1009) if the table had more than 400 columns.

3205384 (1118203)
• Loading data into a table with Implicitly Hidden columns now works as expected in DB2 LUW. An issue

with the SQLUTB loading and unloading from and into DB2 LUW where Implicitly Hidden columns were
being processed incorrectly has been fixed.

3205262 (1118244)
• Loading data using SQLUTB no longer results in an error SQLCODE=-803 when the REPLACE option

is specified. An issue with the SQLUTB LOAD processing where the REPLACE option was being
processed incorrectly has been fixed.

3194416 (1117254)
• There is no longer an issue with loading data using SQLUTB with REPLACE option in a middle job step

when the JCL is submitted using a third party software Control-M. An issue of SQLCODE 2627 with the
JCL loading multiple tables via Control-M being processed incorrectly has been resolved.

3194381 (1117469)
• There is no longer an issue with using SQL Server synonyms without a schema qualifier in SQLUTB

LOAD. An issue with the SQL Server object name delimiter "[]" processed incorrectly has also been
resolved.

3194381 (1117202)

SQL: OpenESQL

Back to the list

• An issue with Visual Studio 2019 caused Micro Focus SQL Tools windows to appear blank. This only
occurred in Visual Studio 2019 version 16.1 or later, with .NET Framework 4.8 installed, and with the
"Optimize rendering for screens with different pixel densities (requires restart)" option enabled.
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3211113 (1118674)

• The OpenESQL run-time system now handles WITH-HOLD cursor correctly when using FETCH FIRST
orientation.

3225154 (1120007)
• You no longer receive an error in the OpenESQL Assistant when trying to run a query that used the

same column referenced by an alias in two or more tables.

3223933 (1119902)
• The SQL Server datetime values are no longer returned with trailing zeros to a host variable of PIC

X(26). An issue with the OpenESQL processing of datetime of SQL Server where padding characters
were being processed incorrectly has been resolved.

3220692 (1119579)
• When calling stored procedures with null indicator host variables, the OpenESQL Run-Time System

now executes correctly without returning an SQLCODE -10000 error.

3219732 (1119869)
• When multiple dynamic XA switches that use OpenESQL technology (such as MSSQL, PostgreSQL,

and ODBC switches) are specified in an Enterprise Sever instance, they are now started without an
error in xa-prepare.

3218857 (1119445)
• The sqlerrd(3) in SQLCA now returns the correct number of rows affected by command INSERT and

DELETE.

3217469 (1119456)
• OpenESQL runtime now handles the @@NESTLEVEL function correctly.

3211849 (1118757)
• An issue with how the SQL managed runtime handles char, varchar, nchar, and nvarchar types in SQL

Server CLR stored procedures where a host variable size is greater than 8,000 has been resolved.

3211090 (1118718)
• The OpenESQL parser now handles SQL statements inside parenthesis correctly.

3210644 (1118643)
• The OpenESQL run-time now handles Informix ODBC errors correctly.

3208869 (1118722)
• The OESQL managed runtime now handles FINAL TABLE statements correctly.

3208718 (1118469)
• An issue with having to perform an ALLOCATE after every OPEN CURSOR to avoid an error has been

resolved.

3206739 (1118395)
• Nested programs with the same PROGRAM-ID now insert records correctly.

3204730 (1118134)
• Native COBOL programs with multiple program id sections no longer failed to compile in 32-bit

compilation. Previously, this failed with redefine symbol error messages.

3204730 (1118842)
• Closing a Windows Forms application compiled with DBMAN=ADO no longer fails with a

NullReferenceException.

3202426 (1117914)
• An issue during COBOL compilation where incorrect error messages (such as "Access plan load error"

or "DBRM not found in plan") could appear no longer occurs. This could happen in release 4.0 or later.

3202086 (1118511)
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• OpenESQL now handles long column names without causing a truncated data warning.

3200934 (1117832)
• There is no longer an issue with expanding host variable groups regardless if whether the GEN-HV-

FROM-GROUP directive is applied. An issue problem with the host variable group processing where
non-sibling host variables were being processed incorrectly has been resolved.

3200753 (1117808)
• OpenESQL now handles and recognizes SQL Server's square brackets correctly.

3199039 (1117614)
• The OESQL JDBC run time now retrieves data correctly via the READ ONLY cursor.

3193117 (1117107)
• The DB2 SQL scripts for the following samples now include database creation - "OO WPF Book", "OO

WPF Book EXEC ADO", and "WPF Book". Check the samples' readmes for instructions.

SQL Option for DB2

Back to the list

• When the XDB directive option IGNORE-NESTED is used without a parameter, XDB ECM now
generates code in the outermost program only.

3218881 (1119399)
• XDB ECM now handles multi-level group host variables correctly.

3215815 (1119114)
• XDB ECM now handles user-defined SQLCODE data items correctly.

3215357 (1119066)
• XDB ECM now handles group host variables in the IN predicate correctly.

3213813 (1118991)
• A new property has been added to the XDB JDBC driver that enables byte array data to be treated as if

it were encoded in the EBCDIC code page of the connection.

3203249 (1119097)

• XDB XA Switch logic now supports z/OS DB2 thread timeouts at XA_START time and reconnects stale
connections but only at XA_START.

3221852 (1119701)
• A problem with XDB XA that caused a z/OS DB2 SAVEPOINT error when a program rolled back to the

SAVEPOINT has been fixed.

3216066 (1119149)
• A thread abend in the XDB Link on Diagnostic Information DRDA flow has been resolved.

3199003 (1117688)
• A problem retrieving the value of the CURRENT PACKAGESET special register from the XDB Link

DRDA/AR client to z/OS DB2 has been resolved.

3186735 (1116600)
• A problem that caused z/OS DB2 to return an error when using packages bound with

DYNAMICRULES=BIND in addition to specifying COMMA as the Decimal Delimiter in the Options
dialog has been fixed.

3204116 (1118276)
• The warning pop-up dialog box for an invalid connection no longer appears when connecting with the

XDB ODBC Driver.

3208889 (1118496)
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• A problem when using the XDB V11 emulation engine that caused the SQLWizard to improperly build
UPDATE statements that update result sets has been fixed.

3209886 (1118568)
• A problem with the XDB CREATE USER SQL statement's SECONDARY ID clause has been resolved.

3206448 (1118263)
• Previously, the V11 radio button was not visible in the About tab of the XDB Server Configuration Utility

even when the V11 engine DLL was available.

3198729 (1117593)
• A problem with recalculating field values during the projection of the result for SUBSTR/SUBSTRING

scalars with parameters 2 and/or 3 that contained field values has been resolved.

3196219 (1117383)
• A problem caused by a case expression built in reverse order has been resolved.

3195822 (1117449)
• The XDB Link DRDA/AR has been enhanced to process z/OS DB2 diagnostic information in all modes.

3187411 (1116687)
• When a location was successfully closed, a problem that prevented it from being marked as closed

caused an error to be generated when subsequently setting a location off-line. This has been fixed.

3184848 (1116525)
• An issue with labeled duration arithmetic or row change timestamps using timestamps with precision

greater than six has been resolved.

3181837 (1116189)
• An issue causing an empty result set where index queues used to optimize correlated subqueries were

reset when the correlated subquery contained an IN predicate with a list of values has been resolved.

3199958 (1117713)
• The XUTLB grammar that processes LOAD statements now supports a NUMRECS clause between the

INTO TABLE clause and the column definition list.

XML Support

Back to the list

• XML PARSE now handles ISO-8859-15 encoded strings correctly in 64-bit mode.

3220045 (1119568)
• The XML run time now handles namespace prefixes correctly in the output XML document.

3219503 (1119447)
• XML PARSE now returns XML EVENT correctly without repeating the same event.

3219154 (1119556)
• The XML run-time system now detects and outputs the special xsi namespace correctly.

3201811 (1117879)
• The PREXML preprocessor now handles the COBOL source correctly, and prevents an unhandled

exception appearing in the IDE.

3200436 (1117735)

• If an environment variable is used in the ASSIGN TO clause, the XML runtime now returns the end-of-
file status correctly.

3220566 (1119552)
• The managed XML syntax support runtime now cleans up all the unwanted empty XML tags.

3209096 (1118515)
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• XML PARSE now parses the subsequent parts of an XML document correctly.

3201432 (1117819)

Resolved Issues | 71



Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 3220454 (1119529)
• 3205144 (1118152)
• 3216998 (1119233)
• 3168018 (1115086)
• 2868839 (1105831)
• 3222038 (1119767)
• 3184732 (1116467)
• 3224515 (1119919)
• 3136118 (1112519)
• 2885283 (1108043)
• 3211043 (1118683)

• 3119471 (1110898)
• 3201628 (1117842)
• 2820860 (1099521)
• 3222960 (1119817)
• 3220991 (1119565)
• 3208034 (1118409)
• 3221354 (1119662)
• 3208854 (1118475)
• 3224700 (1119954)
• 3214528 (1119048)
• 3165853 (1114869)

• 3208489 (1118495)
• 3196128 (1117344)
• 3133097 (1112263)
• 3167774 (1115016)
• 3222951 (1119971)
• 3221465 (1119695)
• 3208613 (1118449)
• 3208093 (1118467)
• 3207104 (1118323)
• 3204665 (1118597)
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Unsupported Functionality
This section includes information about features or functionality that are no longer supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release after release 9.0. The SafeNet Sentinel licenses will not be
supported after release 9.0 and you need to use AutoPass licenses if you use these releases.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
Contact Micro Focus SupportLine for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Supported Third Party Software
The table below lists some of the software requirements and Third Party Software this product is tested
with.

For full details on the supported software, see Software Requirements and Additional Software
Requirements in this product's install notes.

Software Requirements

Integrated Development Environment Visual Studio 2017 (the earliest supported version is
15.9.4).

Visual Studio 2019 (the earliest supported version is
16.4).

.NET framework, .NET Core All .NET framework versions supported

.NET Core 3.1

Java application servers Tomcat 9.0.x

JBoss EAP 7.1.x (where x>=4), and 7.2.x

Oracle WebLogic 12.2.1

IBM WebSphere 9.0 and Liberty 19.0.0.x

Relational databases Oracle 18c and 19c

SQL Server 2014, 2016, 2017, and 2019

DB2 LUW 10.5, 11.1, and 11.5

EDB PostgreSQL 10.x (where x>=5), and 11.x

MySQL 5.7

Middleware IBM WebSphere MQ 8.0

Platform support See http://supportline.microfocus.com/prodavail.aspx

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

2. Alternatively, you can download the product from the Product Updates section of the Micro Focus
SupportLine Web site.

On Windows
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System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• You can produce both 32-bit and 64-bit applications with Enterprise Developer installed on a 64-bit
operating system.

• This product can be installed on earlier versions of Windows but it has not been tested on them.

• Support for development and deployment on Windows 7 has been discontinued.
• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These

platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.

Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.

Note:

• Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK's OpenJDK
8 (u202) with Hotspot.

• This product includes OpenSSL version 1.1.1c.

Visual Studio IDE

You must have Microsoft's Visual Studio 2017 version 15.9.4 or a newer one or 2019 version 16.4 or a
newer one installed in advance.

Note: An issue with Microsoft's Visual Studio 2019 version 16.8 or later affects .NET Core COBOL
projects created with version of Enterprise Developer earlier than 6.0 PU4. To avoid the issue, install
Enterprise Developer 6.0 Patch Update 4 or later with Visual Studio 2019 version 16.8 or later.

You need one of the advanced versions of Visual Studio listed below:
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Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.

Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Enterprise Developer product help inside Visual Studio. When you select
components to install in the Visual Studio installer, click Individual components and check Help
Viewer in the Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install

The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

If not already installed, the Enterprise Developer setup file will install the following components:

• .NET Framework version 4.7.2.
• Debugger
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:

• Azure, WCF, Web, WPF or SQL CLR application development.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.

Installing Visual Studio features that are not currently installed

If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio:

1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio:

1. Start Visual Studio.
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2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

Other Requirements

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Enterprise Developer client and a new licensing server on
the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine.

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following packages: the Windows SDK package and the Microsoft Build Tools
package. See Microsoft Package Dependencies for a full list of actions and operations that require one or
both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location, use
the cblms command line utility post-installation to manage this; see Managing the Microsoft Build Tools
and Windows SDK Packages for more information.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information on the Product Documentation pages on Micro Focus SupportLine, in the product help
for Enterprise Developer for Visual Studio 2017 (click here) or Enterprise Developer for Visual Studio 2019
(click here).

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• Visual COBOL and Enterprise Developer cannot coexist on the same machine.

• If, when you install Enterprise Developer, the machine does not have Microsoft Visual C++ 2017
Redistributable Runtime already installed, it is installed as required by Enterprise Developer. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.

Installation | 77

https://www.microfocus.com/en-us/support
https://www.microfocus.com/documentation/enterprise-developer/ed60/ED-VS2017/GUID-3280F74E-1512-414A-8E56-0F6CBB2F72F8.html
https://www.microfocus.com/documentation/enterprise-developer/ed60/ED-VS2019/GUID-3280F74E-1512-414A-8E56-0F6CBB2F72F8.html


• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

• If you already have Microsoft Build Tools for Visual Studio 2017 installed, you must ensure that it
contains the Visual C++ build tools workload (or at least the individual components contained in that
workload) before you run this installation.

On UNIX

Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

POWER
running AIX

Micro Focus 601 MB 2.40 GB 1.20GB 41 MB

HP IA Micro Focus 1.03 GB 4.10 GB 2.05 GB 79 MB

System Z
running Red
Hat Linux

Micro Focus 485 MB 1.95 GB 970 MB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 743 MB 2.98 GB 1.49 GB 50 MB

SPARC
running
Solaris

Micro Focus 603 MB 2.42 GB 1.21 GB 42 MB

x86-64
running
Solaris

Micro Focus 516 MB 2.07 GB 1.04 GB 33 MB

System Z
running SUSE
SLES

Micro Focus 348 MB 1.40 GB 696 MB 39 MB

x64 running
SUSE SLES

Micro Focus 501 MB 2.01 GB 1.01 GB 50 MB

x64 running
Ubuntu

Micro Focus 505 MB 2.03 GB 1.02 GB 50 MB

x86-64
running
CentOS

Micro Focus 743 MB 2.98 GB 1.49 GB 50 MB

78 | Installation



Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements for Micro Focus Enterprise Developer Unix
Components
These are the software requirements for Micro Focus Enterprise Developer Unix Components:

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library 32-bit
Libra

ry
Name

64-bit
Library
Name

Platform

s390 SUSE 12 SUSE 15 Red Hat 6x Red Hat 7 Red Hat 8

glibc glibc-
*.i686

glibc-
*.x86_64

glibc-
*.s390

X X X

libgcc libgcc
-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X X

libstdc++ libstd
c++-
*.i686

libstdc++-
*.x86_64

libstdc+
+-*.s390

X X X

glibc-locale glibc-
locale
-32bit

glibc-
locale-2

X X

glibc-devel glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

glibc-
devel-
*.s390

X X X

elfutils-libelf elfutil
s-
libelf.i
386
or
elfutil
s-
libelf.i
686

elfutils-
libelf.x86-
64

N/A X X X

libelf-devel elfutil
s-
devel.
i386
or
elfutil
s-

elfutils-
devel.x86
-64

N/A X X X
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Library 32-bit
Libra

ry
Name

64-bit
Library
Name

Platform

s390 SUSE 12 SUSE 15 Red Hat 6x Red Hat 7 Red Hat 8

devel.
i686

libelf-devel libelf-
devel-
32bit-
0.137
-8.19

libelf-
devel-0.1
37-8.19

N/A X X X

libelf1 libelf1
-32bit
-0.13
7-8.1
9

libelf1-0.1
37-8.19

N/A X X

gcc2 gcc*.i
686

gcc*x86_
64

X X X X X X

cpp2 cpp*x86_
64

X X X

ld2 Binutil
s*.i68
6

Binutils*x
86_64

X X X X X X

• ¹ On SUSE 12 AND 15, you can only install the 64-bit version of Enterprise Developer. The glibc-
locale-32bit library is still required by the SafeNet Sentinel licensed components.

• 2 On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• ** Operating system libraries required for PL/I support on both SUSE and Red Hat.
• Libraries marked with an 'X' are not included in the platform and need to be installed separately.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• To execute JVM COBOL code, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 64-bit Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true
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Additional Software Requirements for Micro Focus Enterprise
Developer Unix Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information on the Product Documentation pages on Micro Focus SupportLine, in the product help
for Enterprise Developer for Visual Studio 2017 (click here) or Enterprise Developer for Visual Studio 2019
(click here).

UNIX and Linux Installer Issues

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing
Note:

• This version of the product is a full install.
• See Before Installing first for important information. Also, see Installing as an Upgrade, if you have

an earlier version of Enterprise Developer installed on your machine.

To install this product:

1. Run the edvs2017_60.exe file (or edvs2019_60.exe) and follow the wizard instructions to install
the prerequisite software and the product.
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The installer installs Enterprise Developer, Enterprise Server for .NET, and Micro Focus Analysis
Services Integration. The setup file will also install any missing prerequisite software as listed in the
topic Software Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Depending on how you plan to use the product, there could be dependencies on the Microsoft
Windows SDK and Microsoft Build Tools packages. The installer will install the latest versions of
the Microsoft Windows 10 SDK, and the Microsoft Build Tools for Visual Studio 2017, to their
default locations. Refer to Microsoft Package Dependencies to see if you will require these
packages, and if not, you can configure the installer to skip download and installation (see
Advanced Installation Tasks for more information).

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Micro Focus Enterprise Developer Unix
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_6.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_6.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_6.0_platform -skipsafenet
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• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing and licensing Micro Focus Rumba - available in the product Help and on the Product

Documentation pages on Micro Focus SupportLine
• Installing the Mainframe Components - available in the product Help and on the Product Documentation

pages on Micro Focus SupportLine
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product

Documentation pages on Micro Focus SupportLine

See this information on the Product Documentation pages on Micro Focus SupportLine, in the product help
for Enterprise Developer for Visual Studio 2017 (click here), and Enterprise Developer for Visual Studio
2019 (click here).

On Windows

Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any Patch Updates of the older version of
the product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

• This release can be installed as an upgrade to Enterprise Developer 5.0.
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Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2017_60.exe which contains a number of product .msi files
(Windows Installer packages). When run, edvs2017_60.exe performs some initial system checks then
sequentially installs the .msi files.

Note: The following applies to edvs2019_60.exe when installing the product for Visual Studio 2019.

edvs2017_60.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
edvs2017_60.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-standard Installation 

Format:
edvs2017_60.exe skipmstools=1

Summary:
Full installation, minus the Microsoft package dependencies. A standard installation downloads and
installs the latest Microsoft Build Tools (for Visual Studio 2017) and Windows SDK packages. Refer
to Microsoft Package Dependencies to see if you will depend on these packages, and if not, use the
option above to skip installation of the packages, thus reducing the footprint and duration of the
installation process.

• Non-interactive Installation

Format:
edvs2017_60.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
start /wait edvs2017_60.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
start /wait edvs2017_60.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

To see what parameters you can use, execute the following from the command line:
edvs2017_60.exe /?.

Note:
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• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

On UNIX

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer Unix
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer Unix Components installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer Unix Components Installation
Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_6.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
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-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Documentation Web site for

any updates to the documentation which might have been uploaded.

On Windows

Starting the Product
You are now ready to run Enterprise Developer:

Windows 8.1, and Windows Server
2012 R2

• From your Windows desktop, click the Visual Studio 2017 tile.

Windows 10 and Later • From your Windows desktop, click Start > Visual Studio 2017.

Managing the Microsoft Build Tools and Windows SDK Packages
There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

For example, some project types (for example, .NET Core) require a different version of the Microsoft Build
Tools (the Visual Studio 2019 version) than the one installed (the Visual Studio 2017 version). If you have
already installed the correct version for .NET Core, run cblms after product installation, to update your
environment to use the correct package.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.
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The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by SupportLine.)
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-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10?10.0.17134.0

Viewing the Product Help
Enterprise Developer is configured to display the product help available online on the Micro Focus
SupportLine Web site: https://www.microfocus.com/support-and-services/documentation/.

You can view the product help in one of the following ways:

Online help (default)

Note:

• Your Visual Studio must be configured to show online help by default. Make sure Help > Set Help
Preferences in Visual Studio points to Launch in Browser.

• Ensure that you have an up-to-date version of your browser.

You can access the Help in one of the following ways:

• Click Help > Micro Focus Product Help > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens the Enterprise Developer help or Microsoft's MSDN depending on which keyword in the
editor or part of the UI you are querying.

Local help

Note: If you've had an earlier version of Enterprise Developer installed on your machine, you need to
uninstall any older version of the documentation as follows:

1. Click Help > Add and Remove Content inside Visual Studio.

This starts the Microsoft Help Viewer.
2. Click the Manage Content tab and click Disk.
3. Click Remove next to the line for the Enterprise Developer documentation.
4. Click Update.

The local help is not shipped with the installer. If you prefer to view the help locally on your machine, you
need to download and install it manually as described below.
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1. Download the local help files:

a. Find the download link for local help in your Electronic Product Download email or in the Product
Updates section on the Micro Focus SupportLine Web site and save the files on your machine.

b. Expand the archive on your machine. Ensure that the .msha and the .cab files are in the same
folder.

2. Ensure that the Visual Studio Help Viewer is installed:

a. Click Help inside Visual Studio.

If no View Help command is available, you need to install the Help Viewer manually. See Installing
missing components of Visual Studio in Software Requirements for instructions on how to install it.

3. Install the help in the Help Viewer:

a. Click Help > Add and Remove Content inside Visual Studio.

This starts the Microsoft Help Viewer.
b. Click the Manage Content tab and click Disk.
c. Click the browse button next to Disk and navigate to the folder in which you extracted the local help

files.
d. Select helpcontentsetup.msha and click Open.

This loads the Enterprise Developer documentation.
e. Click Add and then Update.

After the installation is complete, the Enterprise Developer product Help appears in the Help Viewer.
4. Configure Visual Studio to use local help:

a. Start Visual Studio.
b. Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu

click Help > Set Help Preferences > Launch in Help Viewer.
c. Click Help > View Help.

This opens the product help in Microsoft's Help Viewer.

For full details of the Visual Studio Help system, see the MSDN.

Note: On some Windows versions such as Windows 8 or Windows Server 2012 or later, an
issue with Microsoft Help Viewer and Internet Explorer's security being turned on can cause the
Help content to be displayed as raw HTML code. To resolve the issue, you need to turn off the
Internet Explorer Enhanced Security Configuration (IE ESC) for both administrators and users.
Check the Microsoft Windows help for more information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
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packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper6.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:
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1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration

Windows 8.1 From the Windows Start screen, click the License Administration tile.

Windows 10 and Later From your Windows desktop, click Start > Micro Focus License Manager >
License Administration.

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog

box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.
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If you have an authorization code

Authorizing your product when you have an Internet connection
Note:

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates. Go to Micro Focus Product Updates

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number . To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
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violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
© Copyright 2020 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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